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1 Information for interactive test procedures
This documentation provides associated information for the interactive test procedures used to
verify that a product can properly demultiplex, decode, and play back Dolby Digital Plus
bitstreams contained in online delivery formats, including MPEG-DASH and HTTP Live
Streaming.

• New in this version
• Using this test procedure
• Test materials
• Accessing the test materials
• Standards and Dolby documents
• Channel abbreviations
• Contacting Dolby

This documentation is part of the Dolby Digital Plus Online Delivery Kit, which contains all
materials (such as test signals, test applications, web-based interactive test instructions, and
so on) necessary for evaluating a playback product. Choose a method to use the kit:

• Download the kit package to your local web server.

• Access the test materials, and stream test signals to your playback products directly from
the Dolby Interoperability Support Center.

1.1 New in this version
These updates have been made to the latest version of this document.

• Test applications for Android TV and Chromecast are added to the kit and described in this
documentation.

1.2 Using this test procedure
To perform tests on a playback product, follow the detailed instructions generated from the
Dolby System Interactive Test Procedure in conjunction with using this documentation.

This documentation and the Dolby System Interactive Test Procedure are major parts of the
Dolby Digital Plus Online Delivery Kit, which contains all materials (such as test signals, testing
tools, web-based interactive test instructions, and so on) necessary for evaluating a playback
product.

The Dolby Digital Plus Online Delivery Kit is available from the Dolby Interoperability Support
Center (DISC) at https://disc.dolbycustomer.com. DISC is an online service that enables you to
access various Dolby online delivery kits and stream A/V test signals containing Dolby audio
technology to playback products. It is designed to help you deploy Dolby audio technologies
end to end across your over-the-top (OTT) workflows.

To perform playback tests, you must access the Dolby Digital Plus Online Delivery Kit on DISC to
stream test signals to your playback product and to generate test instructions applicable for
your product by using the Dolby System Interactive Test Procedure.

Alternatively, you can download the entire kit to your local disk from Dolby Deliverables on
Demand server (DDoD).
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1.3 Test materials
The system test materials included in the kit are listed in this section.

The system test materials include:

• Dolby Digital Plus for Online Delivery Playback System Development Manual.

• Dolby Digital Plus for Online Delivery Playback System Testing Help.

• Dolby Digital Plus for Online Delivery Content Creation System Development Manual.

• Dolby Digital Plus for Online Delivery Content Creation System Testing Help.

• A browser-based interactive test procedure: This script selects the appropriate test
instructions for your product and exports the test results data. Two versions are supplied in
the kit, one for content creation products and the other for playback products.

• Test signals for Dolby Digital Plus Online Delivery Kit. For each online delivery format, files for
conducting tests and for reference are provided by test case:

• Manifest files or playlist files

• Multiplexed files of multiple encodings

• Test applications: A set of GUI-based applications with Dolby Digital Plus bitstream playback
capability that are designed for these platforms:

• Samsung 2013 Smart TV platform and later

• LG 2013 Smart TV platform and later

• Smart TV Alliance platform

• HbbTV v1.5 and v2.0 platforms

• Xbox 360

• HTML5-supported web browsers

• Android TV

• Roku 4

• Apple TV with tvOS 10

• Google Chromecast

• Testing tools: A set of command-line based tools for validating the conformance of
multiplexed streams to certain specifications.

The organization of the test materials in the kit is listed here:

• <parent directory>

• Documentation

• Playback

• SDM

• Interactive_test_procedure_help

• Interactive_test_procedure

• Content creation

• SDM

• Interactive_test_procedure_help
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• Interactive_test_procedure

• Documentation.html

• Interactive_test_procedure.html

• Bootstrap

• Test_Signals

• elementary_streams

• muxed_streams

• DASH

• HLS

• MP4

• MPEG2TS

• Test_Signals.html

• Test_Apps

• Samsung_app

• LG_app

• SmartAlliance_app

• HbbTV_app

• HbbTV2_app

• HTML5_app

• AndroidTV_app

• Xbox360_app

• Roku

• AppleTV

• Chromecast_app

• Test_Apps.html

• Test_Tools

• hlsvalidator.zip

• mpvaidator.zip

• mp4drop.zip

• Test_Tools.html

• Start_Here.html

• ReleaseNotes.txt

Note: If the product to be tested contains other Dolby technologies, be sure that those
technologies are also fully tested. For details on requirements and testing for other Dolby
technologies, refer to the documentation specific to such technologies.
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1.4 Accessing the test materials
All materials dedicated for online delivery system test can be found on DISC website at https://
disc.dolbycustomer.com. Depending on your test environment setup, you are free to choose to
either download the kit to your local web server or stream the test signals from the DISC
website to your playback product.

About this task
The test materials package is also available for download from the DDoD server. You can choose
either way to access the test materials.

Procedure

1. Log in to the DISC website at https://disc.dolbycustomer.com:

• For new customers to request access to the DISC website, select REQUEST ACCESS in the
login page and complete the registration.

• Registration request will be processed within two working days. You will receive an email
notification allowing you access directly to the DISC website.

After successfully logging into the DISC website, you can browse all Dolby online delivery
development kits, download test files for local testing, or stream test signals from the DISC
website to your playback product directly.

2. Navigate to Dolby Digital Plus Online Delivery Kit for downloading or streaming.

If you choose to run tests with your local web server, download the entire kit to your local
web server (including all of the test signals).

If you choose to stream test signals from the DISC website, you need to download only the
test application for your testing platform.

Related information

Test materials on page 6

1.5 Standards and Dolby documents
Standards and Dolby documents provide additional information to assist you in designing your
product.

Standards
• ETSI TS 102 366 v1.4.1 (2017), Digital Audio Compression (AC-3, Enhanced AC-3) Standard ,

Annex E (normative), available from http://www.etsi.org. This document describes the Dolby
Digital Plus (E-AC-3) bitstream syntax.

• ISO/IEC 14496-12:2012, Information Technology—Coding of Audio-Visual Objects, Part 12: ISO
Base Media File Format , available from http://www.iso.org. This documentation is Part 12 of
the MPEG-4 specification and describes storage of content in a media file.

• ISO/IEC 14496-14:2003, Information Technology—Coding of Audio-Visual Objects, Part 14:
MP4 File Format , available from http://www.iso.org. This documentation is Part 14 of the
MPEG-4 specification. It is based on Part 12 and describes the MPEG-4 container file format.

• ISO/IEC 23009-1:2014, Information Technology—Dynamic Adaptive Streaming over HTTP
(DASH)—Part 1: Media Presentation Description and Segment Formats , available from http://
www.iso.org.
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• ETSI TS 102 796 v1.4.1, Hybrid Broadcast Broadband TV , available from http://www.etsi.org.

• HTTP Live Streaming—draft-pantos-http-live-streaming-23 , available from https://
datatracker.ietf.org. (Search for "pantos".)

• ISO/IEC 13818-1:2013, Information Technology—Generic Coding of Moving Pictures and
Associated Audio Information: Systems , available from http://www.iso.org.

• RFC 6381, The 'Codecs' and 'Profiles' Parameters for "Bucket" Media Types , August 2011,
available from http://tools.ietf.org/html.

• ISO 639-2:1998, Codes for the Representation of Names of Languages, Part 2: Alpha-3 Code ,
as maintained by the ISO 639/Joint Advisory Committee, available from http://www.iso.org.

1.6 Channel abbreviations
This table lists the channel notations used in this document.

Table 1:
Abbreviation Channel

L Left

R Right

C Center

Lc Left Center

Rc Right Center

LFE Low-Frequency Effects

Lfh Left Front Height

Rfh Right Front Height

S Mono Surround

Cs Center Surround

Ls Left Surround

Rs Right Surround

Lscr Left Screen

Rscr Right Screen

Lsd Left Surround Direct

Rsd Right Surround Direct

Lb Left Back

Rb Right Back

Cb Center Back

Lb * Left Back

Rb Right Back

Lvh Left Vertical Height

Cvh Center Vertical Height

Rvh Right Vertical Height

Lrs Left Rear Surround

Rrs Right Rear Surround
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Table 1: (continued)
Abbreviation Channel

Lrs Left Rear Surround

Rrs Right Rear Surround

Lw Left Wide

Rw Right Wide

Tbl Top Back Left

Tbr Top Back Right

Tfl Top Front Left

Tfr Top Front Right

Tl Top Left

Tr Top Right

Ts Top Surround

Ltm Left Top Middle

Rtm Right Top Middle

Lts Left Top Surround

Rts Right Top Surround

SW Subwoofer speaker output

* Lb and Rb correspond to the Lrs and Rrs channels as defined by SMPTE.

1.7 Contacting Dolby
Support services are available to address any questions and to provide advice about integrating
Dolby technology into your product.

For product design or testing, contact Dolby at systemsupport@dolby.com. By utilizing Dolby
expertise, especially during the design process, many problems that might require design
revisions before a product is approved can be prevented.

Dolby is also available to review product plans, including preliminary design information,
markings, displays, and control and menu layouts, with the goal of preventing problems early in
the product development cycle.

If you have comments or feedback about this document, send us an email at 
documentation@dolby.com.
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2 Test overview
General information relevant to the playback system test is provided to assist you in managing
the tests within the interactive test framework.

• Testing a playback product
• Product features and testing
• Test signals
• Listening test
• Product configuration

2.1 Testing a playback product
This topic provides an overview of how to test a playback product by using the Dolby Digital
Plus Online Delivery Kit.

About this task

Refer to the relevant section for detailed instructions.

Procedure

1. Access the Dolby Digital Plus Online Delivery Kit on DISC.

2. Download and install the test application on your product under test.

3. Complete the Dolby Digital Plus Online Delivery System Interactive Test Procedure
questionnaire on DISC.
This generates a test-case list with detailed test instruction for each test case.

4. Play back required streaming test signals hosted on the DISC server (or stored on your local
disk) with the test application.

5. Analyze the resulting test signals using the specified method and tools provided in the Dolby
System Interactive Test Procedure.

6. Submit the test results to Dolby for approval.

2.2 Product features and testing
Many feature-set variations are possible in a product that includes Dolby Digital Plus
technology. Test the features that your product supports.

The Dolby System Interactive Test Procedure uses the form of a questionnaire to request
information about which features are supported by a product, and then uses this information to
provide test instructions for all applicable test cases. Unless otherwise stated in the individual
test instructions, running each test case for each supported feature is generally recommended.

Factors influencing product features are described in this section.

2.2.1 Online delivery formats
A product may support playback of online content in one or more online delivery formats and
profiles, including:
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• MPEG Dynamic Adaptive Streaming over HTTP format (DASH)

• MPEG-DASH Live profile

• MPEG-DASH On Demand profile

• Hybrid Broadcast Broadband TV (HbbTV)

• Apple HTTP Live Streaming format

• Progressive downloading of MP4

• Progressive downloading of MPEG-2 transport streams

2.2.2 Video encoding formats
A product may support one or more video encoding formats and profiles.

The table lists all video profiles included in the Dolby Digital Plus Online Delivery Kit.

Table 2: Video encoding formats and profiles
Encoding Video profiles Resolutions Bit rate Frame rates

H.264 Main profile at level 3.1 640 × 360p 1.5 Mbps 25 and 29.97 fps

Main profile at level
4.0

1280 × 720p 3 Mbps 25 and 29.97 fps

Main profile at level 4.1 1920 × 1080 5 Mbps 25 and 29.97 fps

H.265 Main 10 profile at level
4.0

1280 × 720p 1.5 Mbps 25 and 29.97 fps

Main 10 profile at level
4.1

1920 × 1080 3 Mbps 25 and 29.97 fps

Main 10 profile at level
5.1

3840 × 2106 10 Mbps 25 and 29.97 fps

It is possible to create a Licensed Product that does not support all of these video coding
formats. For example, an HbbTV product targeted specifically at the European market could
support 25 fps only.

Unless otherwise stated in the individual test instructions, run each test case for each
supported video encoding format.

2.2.3 Audio encoding formats
In addition to Dolby Digital Plus, a product may support various audio codecs, such as Dolby
Digital and HE AAC.

It is possible to create a Licensed Product that does not support all of these audio coding
formats. For example, a playback product targeted specifically at the US market could support
decoding of Dolby Digital Plus only.

Unless otherwise stated in the individual test instructions, run each test case for each
supported audio encoding format.

2.2.4 Dual decoding
The Dolby Digital Plus decoder supports dual decoding of main and associated audio programs.
This feature provides the means to support the audio description (AD) service as a receiver mix.
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Note: Dual decoding can be used for many purposes. The most common use of dual
decoding is to provide additional content. One application of dual decoding is to support
audio description.

Some tests are specific to dual decoding and are not applicable to products that do not support
this feature.

Support for dual decoding is required for products where Dolby Digital Plus is supported from
broadcast inputs.

2.2.5 Multichannel and two-channel output
A product with a Dolby Digital Plus decoder can provide a variety of outputs, multichannel or
two channel.

The test procedure questionnaire will request information about which output is considered the
preferred output. The questionnaire will use this information to provide test instructions for
this main output for all applicable tests. This can be any output at the preference of the tester.
We do, however, recommend that you always use the maximum output channel configuration
supported by your product to run each test case. If two-channel output is selected, make sure
all channels available in test streams are correctly downmixed and clearly audible in the two-
channel output.

This section provides expected channel routing by two-, 5.1-, and 7.1-channel products when
playing the channel identification test signals.

Two-channel input

For input test signals with a two-channel configuration, confirm that all channel identifications
in the input test signals are correctly reproduced in the speakers.

For 2.0-channel output product

With a 2.0-channel output product, confirm that the L and R channel identifications in the input
test signals are correctly output to the 2.0 channels, as described in the table.

Left Right

“Left channel“ “Right channel”

For 5.1-channel output product

With a 5.1-channel output product, confirm that the L and R channel identifications in the input
test signals are correctly output to the 5.1 channels, as described in the table.

Left Center Right Left Surround Right Surround LFE

“Left channel“ N/A “Right channel” N/A N/A N/A

For 7.1-channel output product

With a 7.1-channel output product, confirm that the L and R channel identifications in the input
test signals are correctly output to the 7.1 channels, as described in the table.

Left Center Right Left
Surround

Right
Surround

Left Rear
Surround

Right Rear
Surround

LFE

“Left
channel“

N/A “Right
channel”

N/A N/A N/A N/A N/A
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5.1-channel input

For input test signals with a 5.1-channel configuration, confirm that all channel identifications in
the input test signals are correctly reproduced in the speakers.

For 2.0-channel output product

When the input test signal is 5.1 channel, confirm that all channel identifications are correctly
downmixed and output to the L and R channels, as described in the table. The distribution of
channels in the downmix depends on the downmix type (stereo or surround compatible).

Voice Output in channel

Stereo (Lo/Ro) Surround compatible (Lt/Rt)

100 Hz tone L and R L and R

"Left channel" L L

"Right channel" R R

"Center channel" L and R L and R

"Right Surround channel" R L and R

"Left Surround channel" L L and R

For 5.1-channel output product

With a 5.1-channel output product, confirm that all channel identifications in the input test
signals are correctly output to the 5.1 channels, as described in the table.

Left Center Right Left Surround Right Surround LFE

“Left
channel“

“Center
channel”

“Right
channel”

“Left Surround
channel” plus
tone

“Right Surround
channel” plus
tone

100 Hz
tone

For 7.1-channel output product

With a 7.1-channel output product, confirm that all channel identifications in the input test
signals are correctly output to the 7.1 channels, as described in the table.

Left Center Right Left
Surround

Right
Surround

Left Rear
Surround

Right Rear
Surround

LFE

“Left
channel“

“Center
channel”

“Right
channel”

“Left
Surround
channel”

“Right
Surround
channel”

N/A N/A 100
Hz
tone

7.1-channel input

For input test signals with a 7.1-channel configuration, confirm that all channel identifications in
the input test signals are correctly reproduced in the speakers.

For 2.0-channel output product

When the input test signal is 7.1 channel, confirm that all channel identifications are correctly
downmixed and output to the L and R channels, as described in the table. The distribution of
channels in the downmix depends on the downmix type (stereo or surround compatible).
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Voice Output in channel

Stereo (Lo/Ro) Surround compatible (Lt/Rt)

100 Hz tone L and R L and R

"Left channel" L L

"Right channel" R R

"Center channel" L and R L and R

"Right Surround channel" R L and R

"Left Surround channel" L L and R

"Right Rear Surround channel" R R

"Left Rear Surround channel" L L

For 5.1-channel output product

With a 5.1-channel output product, confirm that all channel identifications in the input test
signals are correctly output to the 5.1 channels, as described in the table.

Left Center Right Left Surround Right Surround LFE

“Left
channel“

“Center
channel”

“Right
channel”

“Left Surround
channel,” “Left
Rear Surround
channel,” “Right
Rear Surround
channel” plus tone

“Right Surround
channel” , “Left Rear
Surround channel,”
“Right Rear Surround
channel”plus tone

100 Hz
tone

For 7.1-channel output product

With a 7.1-channel output product, confirm that all channel identifications in the input test
signals are correctly output to the 7.1 channels, as described in the table.

Left Center Right Left
Surround

Right
Surround

Left Rear
Surround

Right Rear
Surround

LFE

“Left
channel“

“Center
channel”

“Right
channel”

“Left
Surround
channel”

“Right
Surround
channel”

“Left Rear
Surround
channel”

“Right
Rear
Surround
channel”

100
Hz
tone

2.2.6 Output interfaces
Two-channel and multichannel outputs can be routed to a variety of interfaces, including:

• HDMI

• S/PDIF

• Line level

• Speakers

• Headphones

Certain tests must be repeated on all digital output interfaces (such as HDMI and S/PDIF)
supported by the product under test. The Dolby Digital Plus 7.1-channel audio decoding and
channel mapping test case specifically requires testing on the digital interfaces.
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2.2.7 Dolby Atmos
A product may support playback of Dolby Digital Plus with Dolby Atmos content.

Some test streams contain Dolby Digital Plus with Dolby Atmos content in it. These test
streams are designed to verify that a product has the capability of playing back Dolby Digital
Plus and reproducing the Dolby Atmos content by using the object audio metadata contained in
the stream.

For a product that includes an HDMI source (output) and supports playback of Dolby Digital Plus
with Dolby Atmos content, it identifies Dolby Atmos content from online delivery formats, and
by default passes it through the HDMI or Audio Return Channel (ARC) to an A/V receiver enabled
for Dolby Atmos. For a product that does not support Dolby Atmos content, it drops the object
audio metadata and decodes the stream as a normal Dolby Digital Plus stream with a backward-
compatible downmixed channel configuration.

2.3 Test signals
Test signals are designed to verify that a product can properly demultiplex, decode, and play
back Dolby Digital Plus bitstreams contained in online delivery formats.

Generally, test signals were created by multiplexing one or more audio elementary streams and
one or more H.264 (or H.265) video elementary streams. Depending on the use case, the audio
elementary streams can be in the Dolby Digital Plus or other format.

2.3.1 Test vectors
A test vector is a set of test signals that are involved in running a test case.

For the MPEG-DASH test cases, a test vector is composed of the test files as listed in the table.

MPEG-DASH profiles Files in a test vector

MPEG-DASH Live One Media Presentation Description (MPD) manifest file (.mpd file)
A sequence of .mp4 files for each video stream
A sequence of .mp4 files for each audio stream

MPEG-DASH On Demand One MPD manifest file (.mpd file)
One .mp4 file for each video stream
One .mp4 file for each audio stream

For the MPEG-DASH HbbTV test cases, a test vector is composed of these test files:

• An MPD manifest file (.mpd file)

• For each audio stream:

• A common initialization segment file (.mp4)

• A sequence of media segment files (.mp4)

• For each video stream:

• A common initialization segment file (.mp4)

• A sequence of media segment files (.mp4)

For the HTTP Live Streaming test cases, a test vector is composed of these test files:

• Playlist files (.m3u8 files)

• A sequence of media segment files (.ts files)
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• A sequence of ID3 format files (.ec3 or .aac files)

Each manifest (or playlist) file uses relative paths to the media files. The relative file locations
between the media files and the manifest file must be kept while a test vector being copied or
moved. This enables the manifest file to locate the media files for playback after you move the
test vectors from one directory to another directory, including to a server location, to simulate a
server/client media streaming process.

2.3.2 File-name channel configuration abbreviations
The test files of this kit include abbreviations that indicate the channel configuration of the test
signal. For example, the manifest file ChID_voices_1280x720p_25fps_h264_2ch_128kbps_ddp.mpd
contains stereo content. The table lists the channel configuration abbreviations.

Table 3: File-name channel configuration abbreviations
Abbreviation Configuration

1ch Mono

2ch Stereo: Left, Right

6ch 5.1 channels: Left, Center, Right, Left Surround, Right Surround, Low-Frequency
Effects

8ch 7.1 channels: Left, Center, Right, Left Surround, Right Surround, Left Rear
Surround, Right Rear Surround, Low-Frequency Effects

2.3.3 Test file naming conventions
A generic naming convention is used for the test files included in the kit.

A test file name is structured in the pattern:

<additional info>_<stream contents>_<video resolution>_<video framerate>_<video codec>_<output
channel configurations>_<bitrates>_<audio codecs>.<file extension>

The file name convention is described in this table.

Term Description

<additional info> Indicates additional information about the test signal, such as payload
byte order. For example, LE indicates that the signal is in little-endian
byte order.

<stream contents> Indicates the stream contents. For example, ChID_voice indicates voice
content for the channel identification test.

<video resolution> Indicates the video resolution.

<video framerate> Indicates the video frame rate.

<video codec> Indicates the video codecs used by a test signal.

<output channel configurations> Indicates output channel configuration.

<bitrates> Indicates the bit rate at which a test file is encoded.

<audio codecs> Indicates the audio codecs used by a test signal.

<file extension> Indicates file formats.

For example, in the file ChID_voices_1280x720p_25fps_h264_2ch_128kbps_ddp.mpd, the name of the
MPEG-DASH test vector represents one Dolby Digital Plus audio track encoded at 128 kbps with
2.0-channel output, and one H.264 video track with a resolution of 1280×720p at a frame rate of
25 fps.
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If a test signal contains more than one video or audio track, the file name will not include the
information that is associated with the multiple tracks. For example, a test signal contains two
audio tracks, one 5.1-channel AAC track at 640 kbps and one 5.1-channel Dolby Digital Plus track
at 256 kbps. The <audio codecs> and <bitrates> information will not be included in its file name.

ChID_voices_1280x720p_25fps_h264_multi_codec.mpd

2.4 Listening test
Listening tests enable you to check for audible failures in the decoding of Dolby Digital Plus.
Listening tests can reveal obvious faults not apparent while conducting other tests.

Perform the listening tests by listening to the product outputs while playing the supplied test
signals. Use these general guidelines for performing all listening tests:

• Choose the audio output to monitor.

• For most tests, it is sufficient to monitor the two-channel analog output using the line-level
or headphone output. (Use the PCM output if no analog outputs are provided.) Make all
necessary equipment connections and product UI selections to listen to this output.

• Unless otherwise indicated, you can instead choose to monitor the digital outputs (for
example, HDMI or S/PDIF).

• Perform listening tests in a quiet environment.

• Listen carefully to the decoded output.

• Verify that the product reproduces the test signal as expected.

• Ensure that any additional processing (such as a virtualizer) is turned off.

• Listen for any loud pops, clicks, distortion, excessive mutes, or other audible objectionable
behavior.

• Perform all of the listening tests for every feature the product supports.

2.5 Product configuration
Run every test with the default configuration settings unless different configuration settings
are provided.

Dynamic range control mode Default mode

Output channel configuration Maximum supported by the output type

Channels to monitor All, simultaneously if possible

Output type All analog and digital outputs

Measurement tool A number of speakers equal to the product maximum output channel
configuration for the specified output type
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3 Test hardware setup
To simulate the online delivery process and play back the test signals, an appropriate hardware
setup for testing is required. Choose the setup best suited for your hardware and network
environment.

• Hardware setup with a local web server
• Hardware setup with DISC
• External decoders

3.1 Hardware setup with a local web server
If you are accessing the Internet from behind a firewall or if you do not have a fast Internet
connection, we recommend testing your playback product with a local web server.

3.1.1 Hardware setup with a local web server for MPEG-DASH and HTTP
Live Streaming
The figure depicts a generic hardware setup with a local server for MPEG-DASH and HTTP Live
Streaming.

Figure 1: Hardware setup with a local web server for MPEG-DASH and Http Live Streaming

The following are required for MPEG-DASH and HTTP Live Streaming testing:
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• An HTTP server must be used to deliver the test signals.

• Headphones connected to the headphone output (or line-level output) of the product under
test.

• A/V unit with 5.1 or 7.1 speakers.

• If the product under test provides HDMI output, connect the HDMI output interface to an
external decoder (such as an A/V receiver) capable of decoding the available digital outputs
(Dolby Digital Plus and Dolby Digital).

• For the multiple bit-rate test case, it is necessary to limit the available bandwidth. Unless
your client software has this feature (for example, in a debug mode), it may be necessary to
use a manually controllable throttling proxy. In case the quality change caused by switching
between different bit rates is not audible, it may be necessary to check which transport
stream segments are actually accessed by analyzing the HTTP server logs or using a network
analysis tool (network sniffer).

• For MPEG-DASH testing, the PlayReady DRM server is reachable over your network for
playback of encrypted test files.

• If the playback product under test is capable of passing through Dolby Digital Plus with
Dolby Atmos content, connect to the HDMI output interface an external decoder (such as an
A/V receiver) capable of decoding the Dolby Digital Plus with Dolby Atmos content, and
connect the decoder output to 5.1.2 speakers.

3.1.2 Hardware setup with a local web server for HbbTV
The figure depicts a generic hardware setup with a local server for HbbTV.
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Figure 2: Hardware setup with a local web server for HbbTV

The following are required for HbbTV testing:

• An HbbTV product (with a remote control) supporting both broadcast and HTTP-based
networks.

• An HTTP server for storage and serving of the CE-HTML application and test signals.

• A broadcaster module that consists of a PC and a DVB-T modulator (for example, a DekTec
DTU-215 USB-2 VHF/UHF Modulator). MPEG-2 compliant transport stream playback software
(for example, StreamXpress, which comes with the DekTec output device) must be installed
on the PC, together with the DVB-T modulator, to simulate a DVB-compliant broadcast
network based on unidirectional MPEG-2 transport streams.

• Headphones.

• A/V unit with 5.1 or 7.1 speakers.

• If the product under test provides HDMI output, prepare an external decoder (such as an A/V
receiver) capable of decoding the available digital outputs (Dolby Digital Plus and Dolby
Digital).
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• For the multiple bit-rate test case, it is necessary to limit the available bandwidth. Unless
your client software has this feature (for example, in a debug mode), it may be necessary to
use a manually controllable throttling proxy. In case the quality change caused by switching
between different bit rates is not audible, it may be necessary to check which transport
stream segments are actually accessed by analyzing the HTTP server logs or using a network
analysis tool (network sniffer).

• The PlayReady and Marlin DRM servers are reachable over your network for playback of
encrypted test files.

• If the playback product under test is capable of passing through Dolby Digital Plus with
Dolby Atmos content, connect to the HDMI output interface an external decoder (such as an
A/V receiver) capable of decoding the Dolby Digital Plus with Dolby Atmos content, and
connect the decoder output to 5.1.2 speakers.

3.2 Hardware setup with DISC
Streaming test signals directly from the DISC website to your playback product saves you the
effort in setting up the web server. Set up your hardware as depicted in this section for online
streaming testing.

3.2.1 Hardware setup with DISC for MPEG-DASH and HTTP Live
Streaming
The figure depicts a generic hardware setup with the DISC website for MPEG-DASH and HTTP
Live Streaming.
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Figure 3: Hardware setup with DISC for MPEG-DASH and HTTP Live Streaming

The following are required for MPEG-DASH and HTTP Live Streaming testing:

• Internet connection with adequate bandwidth for streaming test signals from the DISC
website to your playback product.

• Headphones connected to the headphone output (or line-level output) of the product under
test.

• A/V unit with 5.1 or 7.1 speakers.

• If the product under test provides HDMI output, connect the HDMI output interface to an
external decoder (such as an A/V receiver) capable of decoding the available digital outputs
(Dolby Digital Plus and Dolby Digital).

• For the multiple bit-rate test case, it is necessary to limit the available bandwidth. Unless
your client software has this feature (for example, in a debug mode), it may be necessary to
use a manually controllable throttling proxy. In case the quality change caused by switching
between different bit rates is not audible, it may be necessary to check which transport
stream segments are actually accessed by analyzing the HTTP server logs or using a network
analysis tool (network sniffer).
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• For MPEG-DASH testing, the PlayReady DRM server is reachable over your network for
playback of encrypted test files.

• If the playback product under test is capable of passing through Dolby Digital Plus with
Dolby Atmos content, connect the HDMI output interface to an external decoder (such as an
A/V receiver) capable of decoding the Dolby Digital Plus with Dolby Atmos content, and
connect the decoder output to 5.1.2 speakers.

3.2.2 Hardware setup with DISC for HbbTV
The figure depicts a generic hardware setup with the DISC website for HbbTV.

Figure 4: Hardware setup with DISC for HbbTV

The following are required for HbbTV testing:

Confidential information Test hardware setup

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 24



• An HbbTV product (with a remote control) supporting both broadcast and HTTP-based
networks

• Internet connection with adequate bandwidth for streaming test signals from the DISC
website to your playback product.

• A broadcaster module that consists of a PC and a DVB-T modulator (for example, a DekTec
DTU-215 USB-2 VHF/UHF Modulator). MPEG-2 compliant transport stream playback software
(for example, StreamXpress, which comes with the DekTec output device) must be installed
on the PC, together with the DVB-T modulator, to simulate a DVB-compliant broadcast
network based on unidirectional MPEG-2 transport stream.

• Headphones.

• A/V unit with 5.1 or 7.1 speakers.

• If the product under test provides HDMI output, prepare an external decoder (such as an A/V
receiver) capable of decoding the available digital outputs (Dolby Digital Plus and Dolby
Digital).

• For the multiple bit-rate test case, it is necessary to limit the available bandwidth. Unless
your client software has this feature (for example, in a debug mode), it may be necessary to
use a manually controllable throttling proxy. In case the quality change caused by switching
between different bit rates is not audible, it may be necessary to check which transport
stream segments are actually accessed by analyzing the HTTP server logs or using a network
analysis tool (network sniffer).

• The PlayReady and Marlin DRM servers are reachable over your network for playback of
encrypted test files.

• If the playback product under test is capable of passing through Dolby Digital Plus with
Dolby Atmos content, connect to the HDMI output interface an external decoder (such as an
A/V receiver) capable of decoding the Dolby Digital Plus with Dolby Atmos content, and
connect the decoder output to 5.1.2 speakers.

3.3 External decoders
If the product supports bitstream output over an available digital interface (for example, HDMI
or Sony/Philips Digital Interconnect Format (S/PDIF)) output, an external decoder is required for
testing.

To ensure that expected results of some tests can be correctly verified, the external decoder
should be capable of displaying sample rate and channel configuration information for the
signal being processed.

You can use an external decoder product (for example, an ) with these characteristics:

• Support for Dolby Digital Plus 5.1-channel decoding.

• 5.1-channel speaker outputs.

• S/PDIF input that meets the requirements defined in the IEC 60958 and IEC 61937
specifications.

• An HDMI input for testing products that function as HDMI sources (for example, set-top
boxes), or an HDMI output for testing products that function as HDMI sinks (for example,
TVs). The HDMI must have these characteristics:

• Capable of supporting a single IEC 61937 stream with an IEC 60958 sample rate of 128,
176.4, or 192 kHz

• Implements version C or later of the CTA-861 standard
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When testing an HDMI sink product that is enabled to use the HDMI Audio Return Channel (ARC)
feature, ensure that the external decoder is also ARC enabled.

An external decoder with these capabilities enables you to use a single product to perform all
tests requiring an external decoder.

Ensure that any effects (or other processing) on the decoder are turned off during testing.
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4 The interactive test procedure
This development kit includes a browser-based interactive test procedure to assist you through
the testing process for the playback kit Implementation.

4.1 Testing with the interactive procedure
Follow these instructions to generate and complete the interactive test procedure.

Prerequisites

• Before you start, make sure you are familiar with product variations.

• The interactive test procedure does not support Internet Explorer. We recommend using
recent version of Mozilla Firefox.

• JavaScript support must be enabled in your browser.

Procedure

1. Log in to the DISC website at https://disc.dolbycustomer.com.

2. Navigate to the Dolby Digital Plus Online Delivery Kit  > Interactive Test Procedure >
Interactive Test Procedure for Playback.
If this is the first time you run the interactive test procedure, an empty product
configuration questionnaire appears. Otherwise, you may need to clear the settings from

last time by clicking Settings , and then New session.

3. Fill in the product configuration questionnaire.

To obtain the list of relevant test cases for your system, you must answer some questions
regarding system capabilities. The questionnaire may have multiple pages. In a completed
questionnaire, every required question must have a  sign.

As you fill in the questionnaire, certain questions and answers automatically become
inactive, because they are incompatible with the feature you are selecting.

In case you wish to specify something to the Dolby team regarding a certain question, you
can use the option Add a comment.

4. Click Next when you have completed each page, then click Done when you have completed
the entire questionnaire.
A test-case list is generated and appear in a new page, with the required and recommended
tests for your system. You must complete all required tests listed for your system
capabilities.

5. Click Settings , and then Download playlists, to save a .zip playlist file to your local disk:

• The playlist file contains test signal URLs and will be used by the some of the test
applications provided in the Dolby Digital Plus Online Delivery Kit.

• Click Test Overviews at the top of the page to go back to the test-case list view.

6. Optional: Sort, filter, and save the test-case list for better orientation and for future
reference.
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• You can show or hide columns using the check boxes on the side panel (for example,
Approach or Standard). By default, the list shows Test case, Purpose, Online Delivery
Format, Digital Right Management, Video Profile, Requirement and Status.

• You can sort the list by clicking the column headers.

• You can apply filtering criteria on a relevant column in the list, using the filtering check
boxes on the side panel.

• You can save or load a session under Settings > Session management. The settings you
filled in for your system are saved in a .json log file.

7. For each test case:

a) Click the test case in the list, and read the test-case description and procedure.

b) Follow the setup requirements and instructions on the page to complete the tests.

c) Compare the test results with the expected results shown on the page, and select Pass or
Fail.

d) To go to the next test case in the list, click Next.

If you want to see the entire list again and check the tests status, click Up one level or
Tests Overview.

100% Test suite progress indicates that you have completed all of the required tests.

8. Save the printable versions of the questionnaire and test cases under Settings > Print
versions.

Click All to generate a .html file that contains the complete questionnaire and the test-case
list together with test results.

Related information

Test materials on page 6
Accessing the test materials on page 8
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5 Test applications
GUI-based applications with the capability of playing back Dolby Digital Plus bitstreams are
designed for several platforms.

• Test application for the Smart TV platform
• Test application for HbbTV compliant products
• Test application for HbbTV 2.0 compliant products
• Test application for Xbox 360
• Test application for an HTML5-supported web browser
• Test application for Android TV
• Test applications for Apple TV
• Test application for Roku TV
• Test application for Chromecast

5.1 Test application for the Smart TV platform
Dolby provides test applications for playing back Dolby Digital Plus bitstreams on Smart TV
platforms, including Samsung Smart TV, Samsung Tizen TV, LG Netcast TV, LG WebOS TV and TV
products compliant with the Smart TV Alliance specification.

Note: The method of installing the test application for a Smart TV Alliance product varies on
a case-by-case basis. The LG Smart TV is used here as an example of a Smart TV Alliance
product. The usage of the test application is similar on most Smart TV products.

5.1.1 Setting up testing infrastructure
To run tests with the test application, you must set up the testing infrastructure best suited for
your environment. You can choose connecting the Smart TV to either a local web server or the
DISC website.

Connecting the Smart TV to a local web server

If you are accessing the Internet from behind a firewall or if you do not have a fast Internet
connection, set up your Smart TV as described in this section.

About this task

To simulate a server/client media streaming process, the Smart TV under test must be
connected to a local web server that hosts the test signals.
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Procedure

1. Set up hardware components as described in the section that addresses hardware setup
with a local web server.

2. Download the entire playback kit onto your local web server from the DISC website (https://
disc.dolbycustomer.com), and unpack it to an appropriate directory.

3. Configure the IP address of the local web server.

4. Assign a valid IP address for the Smart TV. (Usually, the IP is set automatically. For the
procedure of setting the IP address for a Smart TV, refer to the user's manual of the Smart TV
product.)

5. Verify the connection by accessing the Start_Here.html page of the kit in the Smart TV built-in
web browser.

Related information

Hardware setup with a local web server on page 19

Connecting the Smart TV to the DISC website

If you have access to an Internet connection with adequate bandwidth for streaming a test
signal to your playback product, set up your testing infrastructure as described in this section.

About this task

To stream test signals from the DISC website to the Smart TV under test, you must ensure that
the Smart TV has an Internet connection and is able to access the DISC website.

Procedure

1. Set up hardware components as described in the section that addresses hardware setup
with the DISC website.

2. Connect the Smart TV to Internet. (For the procedure for accessing the Internet, refer to the
user's manual for the Smart TV product.)

3. Verify the connection by accessing the DISC website at https://disc.dolbycustomer.com in
the Smart TV built-in web browser.

Related information

Hardware setup with DISC on page 22

5.1.2 Preparing a test signal list for the test application
You can first screen out the relevant test cases for your system by using the interactive test
procedure, and then manually provide the test application with a list of the selected test signals
and their URLs so that the test application is able to locate those test signals for playback.

Procedure

1. Log in to the DISC website at https://disc.dolbycustomer.com.

2. Navigate to the Dolby Digital Plus Online Delivery Kit , and within the kit, click Interactive
Test Procedure.

3. Complete the entire questionnaire of the interactive test procedure, and then click Done.

One step of the questionnaire requires information about the directory where the test
signals are stored. Choose the correct location, Local server or DISC website. If Local server
is selected, enter the path information in the text box as required.
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A test-case list is generated and appears in a new page, with the required and recommended
tests for your system. You must complete all required tests listed for your system
configuration.

4. Click Settings , and then Download playlists, to save a c_playlist.zip file to your local disk.

This playlist file contains the URLs to the required test signals.

5. Unpack the c_playlist.zip file.

This unzipped folder will be used later to import the test-case list to the test application.

6. To generate a new playlist for another set of test signals, repeat steps 3 to 5.

Related information

Testing with the interactive procedure on page 27

5.1.3 Deploying the test application on the Smart TV
Download the correct test application .zip file, and deploy the applications on your target Smart
TV.

Deploying the test application on a Samsung Smart TV

Deploy the test application on a Samsung Smart TV for running tests.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• You have created the playlist file for your product under test by using the interactive test
procedure.

• You must prepare a USB flash drive with minimum memory space of 10 MB.

Procedure

1. Download or copy the Samsung_Orsay_app.zip file to an appropriate directory on your local PC.

If you have downloaded and unpacked the kit on your local web server, locate the .zip file in
the <kit parent directory>/Test_Apps/Samsung_app directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Unzip the file Samsung_Orsay_app.zip, and make sure the unzipped folder (Samsung) contains
the files index.html and config.xml, the c_playlist folder, and other files and subfolders.

3. Import the customized test-signal playlist by replacing the c_playlist subfolder in the Samsung
folder with the unzipped c_playlist folder generated by using the interactive test procedure.

The new c_playlist contains links to test signals that are relevant to your product under test
only. If you do not use the customized playlist, a default test-signal playlist will appear when
running the test application.

If you need to test another set of test signals, you must generate a new playlist with the
Playback Kit Interactive Test Procedure, and then manually replace the playlist folder with
the updated one.
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Make sure that the file names and subfolders structure within the unzipped Samsung folder
are unchanged.

4. Copy the entire folder Samsung to the root directory of the USB flash drive.

5. Switch on the Smart TV.

6. Press the SMART HUB button on the remote control.

7. Select More Apps from the bottom of the TV screen.

The user interface for accessing the More Apps page may differ across different Smart TV
versions. Refer to the Smart TV user's manual for more information.

8. Connect the USB flash drive to the TV.

Note: The TV may not detect the test application in the USB flash drive if you connect it
to the TV earlier than this step.

If the New device connected message prompts, press the return (back) button on the
remote control.

The OttTestApp appears in the More Apps list and is ready for use.

9. Click on the application icon to run it.

Note: This version of the test application cannot be installed on the Samsung Smart TV.
You must keep the USB flash drive connected to the TV while using the test application.

Related information

Accessing the test materials on page 8

Deploying the test application on a Samsung Tizen TV

To install the Dolby test application to a Samsung Tizen TV, you must connect the TV under test
to a computer with the Samsung Tizen TV system development kit properly installed on it.

Setting up the development environment

Set up the development environment for deployment of the test application.

Preparing the Samsung TV for development
The TV under test must switch to the development mode for installing the Dolby test
application.

Procedure

1. Update the TV firmware to the latest version (later than 1400.0).

2. Set the TV to Developer Mode.

a) Switch on the TV, and press the Smart Hub button on the remote control.

b) Enter the Apps screen.

c) In the Apps screen, press the number buttons 1, 2, 3, 4, 5 in sequence on the remote
control.

An interface appears for setting Developer Mode.

d) Set the Developer Mode to On.

e) Enter the IP address for the PC that will be connected to this TV.

f) Reboot the TV.

It might be necessary to disconnect the TV power plug to make the settings effective.

If the TV is successfully set to the development mode, a red sign reading Developer Mode
will appear on the Apps screen after rebooting.

Confidential information Test applications

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 32



For detailed information, see http://www.samsungdforum.com/TizenGuide.

3. Verify the IP address for the TV, and make sure the TV and the PC are connected to the same
network (same router).

The Samsung system development kit will be installed on the PC for deployment of the test
application.

Installing the Samsung Tizen TV system development kit
Install the Samsung Tizen TV system development kit on a PC to deploy the Dolby test
application on a Samsung Tizen TV.

Procedure

1. Download and install the Tizen TV system development kit on a PC that will be used to deploy
the test application on the TV.

Tizen TV system development kit is available at http://www.samsungdforum.com/
TizenDevtools/SdkDownload. Choose the version that suits your operating system.

Note: The PC must run Windows 8.1 or later. We recommend using Windows 10.

2. Run the Tizen 2.4 IDE, and create the security profile as described in http://
www.samsungdforum.com/TizenGuide/tizen1261/index.html.

Refer to the security profiles section only.

3. Check the IP address for the PC, and make sure that the TV and the PC are connected to the
same network (same router).

Deploying the test application

Use the Tizen 2.4 IDE to deploy the Dolby test application on the Samsung Tizen TV.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• The TV and the PC are connected to the same network (same router).

• A PC running Window 8.1 (or later) is required. We recommend Windows 10.

• The development environment has been correctly established.

• You have created the playlist file for your product under test by using the interactive test
procedure.

Procedure

1. Download or copy the Samsung_tizen_app.zip file to an appropriate directory on the local PC.

If you have downloaded and unpacked the kit on your local web server, locate the .zip file in
<kit parent directory>/Test_Apps/Samsung_app directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Import the customized test-signal playlist by replacing the c_playlist subfolder in the
Samsung_tizen_app.zip file with the unzipped c_playlist folder generated by using the interactive
test procedure.

The new c_playlist contains links to test signals that are relevant to your product under test
only. If you do not use the customized playlist, a default test-signal playlist will appear when
running the test application.
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If you need to test another set of test signals, you must generate a new playlist with the
Playback Kit Interactive Test Procedure, and then manually replace the playlist folder with
the updated one.

Make sure the .zip file name and the files and subfolder structure within the .zip file are
unchanged.

3. Switch on the target TV.

4. Launch Tizen IDE-2.4 in Tizen SDK-2.4 on the PC.

5. Import the Dolby test application project into Tizen IDE-2.4.

a) In the Project Explorer panel, right-click on the blank space and select Import.

b) In the Import window, select General > Existing Projects into Workspace > Next >
Select archive file > Browse....

c) Navigate to the Samsung_tizen_app.zip file, and select it.

The project content appears in the Projects box.

d) Click Select All > Finish.

6. Establish a connection between the PC and the Samsung TV under test:

a) In the Connection Explorer panel, click the Remote Device Manager icon.

The Connection Explorer panel can be opened by clicking Window > Show View >
Connection Explorer.

b) In the Remote Device Manager window, click New, fill in the required information, and
then click Save.

Here is an example. The IP field must match the IP address displayed on the target TV
screen.

Figure 5: Connecting the PC and the Samsung TV

c) In the Remote Device Manager window, highlight the TV that you want to connect to,
and click Connect.
The connected TV will be shown in the Remote Device Manager window.

7. Deploy the test application on the target TV.

a) In the Project Explorer panel, right-click on the test application project name (for
example, ottTestApp - tv -samsung- 2.4).

b) Click Run As > 1 Tizen Web Application.
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The deployment process may take a few minutes.

Results
After the deployment process completes successfully, the test application runs automatically
on the TV.

Deploying the test application on an LG Netcast TV

Deploy the test application on an LG Netcast TV for running tests.

Prerequisites

• You must have an LG developer account. You can apply for one from http://
developer.lge.com/main/Intro.dev.

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• You have created the playlist file for your product under test by using the interactive test
procedure.

• You must prepare a USB flash drive with minimum memory space of 10 MB.

Procedure

1. Download or copy the LG_netcast_app.zip file to an appropriate directory on your local PC.

If you have downloaded and unpacked the kit on your local PC, locate the .zip file in the <kit
parent directory>/Test_Apps/LG_app directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

The LG_netcast_app.zip contains:

• LG_app_raw.zip:

• index.html and other files and subfolders

• icon.png

2. Import the customized test-signal playlist by replacing the c_playlist subfolder in the
LG_app_raw.zip file with the unzipped c_playlist folder generated by using the interactive test
procedure.

The new c_playlist contains links to test signals that are relevant to your product under test
only. If you do not use the customized playlist, a default test-signal playlist will appear when
running the test application.

If you need to test another set of test signals, you must generate a new playlist with the
Playback Kit Interactive Test Procedure, and then manually replace the playlist folder with
the updated one.

The importing step can also be performed after the registration procedure.

Make sure the .zip file name and the files and subfolders structure within the .zip file are
unchanged.

3. Register the test application at the LG developer website http://developer.lge.com/apptest/
retrieveApptestReg.dev:

a) Upload the LG_app_raw.zip file to the LG website for DRM packaging.

b) Download the resulting DRM-packaged application .zip file to your local PC.

For detailed instruction, refer to http://webostv.developer.lge.com/develop/app-test/.

The resulting DRM-packaged application file (.zip) contains this folder structure:
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• <XXXX> (contains index.html, manifest.xml, .png images, and other files and subfolders)

<XXXX> is an ID number created by the LG website.

4. Unzip the <XXXX>.zip file, and manually place it in this folder structure:

• lgapps

• installed

• <XXXX> (contains index.html, manifest.xml, .png images, and other files and subfolders)

5. Copy the entire lgapps folder to the root directory of a USB flash drive.

6. Switch on the Smart TV.

7. Press the SMART HUB button on the remote control.

8. Select More Apps from the bottom of the TV screen.

9. Connect the USB drive to the TV.

You may need to choose the USB icon  in the upper-right corner of the GUI to

designate the data source.

The application name appears in the More Apps list and is ready for use.

10. Click on the application icon to run it.

Note: This version of the test application cannot be installed on the LG Smart TV. You
must keep the USB drive connected to the TV while using the test application.

Related information

Accessing the test materials on page 8

Deploying the test application on an LG WebOS TV

To install the Dolby test application to a LG WebOS TV, you must connect the TV under test to a
PC with the LG WebOS TV system development kit properly installed on it.

Setting up the development environment

Prepare the development environment for the webOS TV under test and the development PC.

Prerequisites

• The PC is connected to the network.

• The webOS TV has access to the Internet.

About this task
This document lists the main setup steps only. For detailed instruction on how to prepare an LG
webOS TV for deploying a test application, refer to the webOS developer website at http://
webostv.developer.lge.com/.

Procedure

1. Install the system development kit for the webOS TV on your PC.

The system development kit contains an IDE tool for connecting the PC to the webOS TV.

2. Create an LG developer site account at http://developer.lge.com/main/Intro.dev.

3. Install the developer mode app on the TV under test.

The developer mode app is available for download at the LG store.

4. Enable the developer mode on the TV under test.

Confidential information Test applications

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 36

http://webostv.developer.lge.com/
http://webostv.developer.lge.com/
http://developer.lge.com/main/Intro.dev


Note: The developer mode is enabled for a limited time only. You must extend the
Developer Mode session before the time expires. See http://webostv.developer.lge.com/
develop/app-test/ for more information.

5. Use the IDE to connect the computer to the TV under test.

For detailed information, refer to Connecting with IDE  at http://webostv.developer.lge.com/
develop/app-test/.

Deploying the test application

With the TV and PC connected successfully, you can deploy the Dolby test application with the
IDE.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• The TV and the PC are connected with IDE.

• The developer mode is enabled on the target TV.

• You have created the playlist file for your product under test by using the interactive test
procedure.

Procedure

1. Download or copy the LG_webos_ide_app.zip file to an appropriate directory on your local PC.

If you have downloaded and unpacked the kit on your local PC, locate the .zip file in the <kit
parent directory>/Test_Apps/LG_app directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Unpack the LG_webos_ide_app.zip file.

3. Import the customized test-signal playlist by replacing the c_playlist subfolder in the
LG_webos_ide_app folder with the c_playlist folder generated by using the interactive test
procedure.

The new c_playlist contains links to test signals that are relevant to your product under test
only. If you do not use the customized playlist, a default test-signal playlist will appear when
running the test application.

If you need to test another set of test signals, you must generate a new playlist with the
Playback Kit Interactive Test Procedure, and then manually replace the playlist folder with
the updated one.

Make sure that the file names and subfolders structure within the LG_webos_ide_app folder
are unchanged.

4. Launch the webOS TV IDE.

5. Import the Dolby test application project into webOS TV IDE.

a) In the menu bar, select webOS Menu > Import webOS Project > Browse.
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b) Navigate to the LG_webos_ide_app folder, and select it.

The project content appears in the Projects panel.

c) Click Select All > Finish.

6. Deploy the test application on the target TV.

a) In the Project Explorer panel, right-click on the test application project name (for
example, LGTestApp).

b) Click Run As > Run Configuration.

c) Click the Target drop-down list to select the target TV.

d) Click the Run button.

The deployment process may take a few minutes. Reboot the target TV as needed.

Results
After the deployment process completes successfully, the test application runs automatically
on the TV.

5.1.4 Test application controls
Operate the test application to perform different types of test cases.

Controls on the test application can be adjusted by:

• Using the arrow keys on the remote control to focus on the needed function in the GUI, and
then pressing the Enter key on the remote control

• Using the remote control key dedicated to a certain function

• GUI overview
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• Output messages

• Playing test signals on the Smart TV

• Fast-forwarding and rewinding

• Switching between different audio tracks

GUI overview

All application functions can be managed through the GUI workspace.

Figure 6: Test application GUI

1 Playlist
Displays a list of test signals. Test signals are organized in a hierarchy. Use the arrow and
return keys on the remote control to navigate through different levels.

2 Audio Component
Displays audio and video tracks with different encodings presented in a test stream.

3 Test signal description
Displays information on a selected test signal, such as bit rate, available audio and video
tracks, the purpose of the test signal, and so on.

4 Playback window
Displays video content of a currently playing test signal.

5 Menu
Contains functions such as exit, help, and so on.

6 URL information
Displays the URL of the currently playing test signal.
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7 Output
Displays information, such as playback status, bit rate, error messages, and so on.

8 Information
Click this key to display information on a selected test signal, such as bit rate, available
audio and video tracks, the purpose of the test signal, and so on.

9 Full screen
Click this key to play back video content in full-screen mode.

10 Playback control
Use these keys to control the playback process (from left to right: previous, rewind, play,
pause, stop, fast forward, and next).

Output messages

The Output area provides information including playback status, bit rates, error, and so on.

Table 4: Output messages from the test application
Output messages Description

Loading Indicates the status of test signal buffering.

End of playback Indicates that the playback has stopped.

Current bitrate: # kbps Indicates the bit rate of an audio track that is currently playing.
With this message, you can verify whether switching between
tracks with different bit rates occurs. This information is
especially useful for the multi_rate and multi_av_rate test cases. This
message does not display if your product does not support
switching.

Connection failed Indicates that the test application fails in an attempt to connect
to the web server.

Network disconnected Indicates that the network connection is broken.

Render error Indicates an internal error.

Stream not found Indicates that the specified test signal does not exist.

Unknown: # (error code) Error code returned by the player integrated in the test
application. The returned error code can be used for debugging.

Playing test signals on the Smart TV

Prerequisites

• The Smart TV must have access to the test signals:

• If a local web server is used, ensure that all test signals have been downloaded and stored
in that server.

• If the DISC website is used, ensure that the Smart TV has an Internet connection and is
able to access the DISC website.

• The USB flash drive containing the test application files must be connected to the Smart TV.

• The playlist file has been successfully imported into the test application.

Procedure

1. Start the test application.
The application GUI appears.

2. Navigate to and highlight the test signal you want to play in the Playlist panel by using the
arrow keys on the remote control:
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• If you have successfully imported a playlist to the test application, only those selected
test signals are displayed in the Playlist panel. Test signals are organized in hierarchical
structure. Higher-level items are indicated by a folder icon  next to them.

• Information about a highlighted test signal is displayed next to the Playlist panel for
approximately 15 seconds. To toggle the display on and off, press the info key on the
remote control.

• You can return to the parent-level playlist by pressing the Return key on the remote
control.

3. Play the highlighted test signal by pressing the Enter key on the remote control.

The test signal being played has a triangle icon on its left side.

• If playback of a test signal is successful, the Output panel displays Loading... and then
the Current bitrate: # kbps, and the video plays back in the window in correct alignment
with the audio.

Note: The current version of LG Smart TV does not support displaying bit-rate
information.

Figure 7: Playing a test signal

• If playback of a test signal fails, the Output panel displays error messages.

Note: Adverse behaviors during playback (such as audible pops, clicks, or muting)
cannot be detected by the test application, and no error indication will display.
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Figure 8: Error message

• If network bandwidth fluctuates during playback, the Current bitrate: # kbps changes,
indicating that audio track switching occurs to adapt to the current bandwidth.

Related information

Preparing a test signal list for the test application on page 30
Deploying the test application on a Samsung Smart TV on page 31
Deploying the test application on an LG Netcast TV on page 35
Output messages on page 40
Accessing the test materials on page 8

Playing a test signal by specifying a URL

It is also possible to play a test signal by pointing at its URL.

Procedure

1. Go to the Menu, and select Load Single URL.
A text box appears with a virtual keyboard.

2. Enter the URL of an individual test stream in the text box.

3. Select the Load button to play the test signal.

If the URL is entered incorrectly, clicking the Load button returns the application to its main
view.

If successfully loaded, the test signal starts playing back.

Fast-forwarding and rewinding

Procedure

1. Click the fast-forward button on the GUI once to jump forward ten seconds.

2. Click the rewind button on the GUI to jump back ten seconds.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.
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Procedure

1. Select the Components tab on the upper-left corner of the GUI.

Note: Your product may not support switching between tracks; in this situation, the
Components tab displays Switching between tracks is not supported.

2. Make sure that the tracks information listed in the Audio Component panel matches what is
described in the Information box.

The tracks information listed in the Audio Component panel is extracted directly from the
test signal. If this information does not match what is described in the Information box, the
test signal is not correctly decoded.

3. Highlight the audio track you want to play.

4. Press the Enter key on the remote control.

The selected track has a tick on the right side.

Figure 9: Audio component panel in the test application

5.2 Test application for HbbTV compliant products
This test application is designed for playing back Dolby Digital Plus bitstreams on HbbTV-
compliant products.

Note: In this release, use this link https://d9zmmjtv72w5o.cloudfront.net/OnDelKits/DDP/
Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/Start_Here.html for accessing test materials.

5.2.1 Setting up testing infrastructure
To run tests with the test application, you must set up the testing infrastructure best suited for
your environment. You can choose to connect the HbbTV product to either a local web server or
to the servers set up by Dolby for running HbbTV tests.

The servers set up by Dolby consist of an app server that hosts the CE-HTML–based HbbTV test
application and the DISC website that contains all of the test signals.
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Setting up the HbbTV hardware components and local web server

If you are accessing the Internet from behind a firewall, or if you do not have a fast Internet
connection, set up your HbbTV product and local HTTP server as described in this section.

Prerequisites
The HTTP server used for streaming test signals must have Hypertext Preprocessor (PHP)
installed on it.

About this task

To simulate a server/client media streaming process, the HbbTV product under test must be
connected to a local HTTP server that hosts the test signals and to a broadcaster module that
serves the DVB-T transport stream.

Procedure

1. Download the entire playback kit onto your local HTTP server from the DISC website (https://
disc.dolbycustomer.com), and unpack it to an appropriate directory on the local HTTP server.

2. Configure the IP address of the HTTP server. If you want use the example DVB-T transport
stream (example_mpeg2ts_local_AIT.ts) provided in the playback kit package, configure the HTTP
server IP to 192.168.0.10.

3. Copy everything in the <kit parent directory>/Test_Apps/HbbTV_app/ directory of the playback kit
package to the Http_Server_URL/HbbTV_app/ directory of the HTTP server.

Within this document, Http_Server_URL constitutes a reachable HTTP server address (for
example, http://testserver/).

The HbbTV application is contained in the <kit parent directory>/Test_Apps/HbbTV_app/ directory.
When copying, make sure that all the contained subdirectories and files are included and the
directories structure is not flattened.

4. Ensure that all test signals (subdirectories and files) are available in the Http_Server_URL/<kit
parent directory>/Test_Signals directory of the HTTP server. Make sure that the directories
structure is not flattened.
For example, if you unpacked the kit to the root directory of the local HTTP server, all of the
test signals must be available in Http_Server_URL/Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/
Test_Signals.

5. Connect the HbbTV product under test to the HTTP server with an Ethernet connection:

a) Assign a valid IP address for the HbbTV. (Usually, the IP address is set automatically. For
the procedure of setting the IP address for a HbbTV, refer to the user's manual of the
HbbTV product.)

b) Verify the connection by accessing a web page with Http_Server_URL in the HbbTV built-in
web browser.

6. Connect a PC to a DVB-T modulator.

The PC and the DVB-T modulator comprise the broadcaster module.

7. Connect the HbbTV to the DVB-T modulator with a coaxial cable.

8. Verify the connection between the HbbTV and the broadcaster module:

a) Copy the example .ts file (example_mpeg2ts.ts) to the PC.

The example .ts file is contained in the playback kit package at <kit parent directory>/
Test_Apps/HbbTV_app/data/example_mpeg2ts.ts.

b) Run the MPEG-2 transport stream player (for example, StreamXpress) on the PC.
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c) Open and play the example .ts file (example_mpeg2ts.ts) in the MPEG-2 player (StreamXpress).

d) Search for the HbbTV channel on the HbbTV product. If the content of the .ts file can be
correctly displayed on the HbbTV, the connection is successful. Otherwise, check the cable
connection, or refer to the user's manual of the DVB-T modulator for further information.

9. Set up the audio output hardware components as described in the section that addresses
hardware setup.

Related information

Hardware setup with a local web server for HbbTV on page 20

Connecting the HbbTV to the DISC website

If you have access to an Internet connection with adequate bandwidth for streaming test
signals to your playback product, set up your testing infrastructure as described in this section.

About this task

To stream test signals from the DISC website to the HbbTV product under test, you must ensure
that the HbbTV product has an Internet connection and is able to access both the DISC website
and the app server hosting the CE-HTML–based HbbTV test application.

Procedure

1. Connect the HbbTV product to the Internet. (For the procedure of accessing the Internet,
refer to the user's manual of the HbbTV product.)

2. Access streaming.dolby.com with the HbbTV built-in web browser to verify the network
connectivity between the HbbTV product and the app server that hosts the HbbTV test
application.

3. Access the DISC website at https://disc.dolbycustomer.com with the HbbTV built-in web
browser to verify the network connectivity between the HbbTV product and the DISC website
that hosts the test signals.

4. Connect a PC to a DVB-T modulator.

The PC and the DVB-T modulator comprise the broadcaster module.

5. Connect the HbbTV to the DVB-T modulator with a coaxial cable.

6. Verify the connection between the HbbTV and the broadcaster module.

a) Download the example .ts file (example_mpeg2ts.ts) to the PC from the web page <kit starting
page>/Test_Apps/HbbTV_app/data/ on the DISC website (https://disc.dolbycustomer.com).

b) Run the MPEG-2 transport stream player (for example, StreamXpress) on the PC.

c) Open and play the example .ts file (example_mpeg2ts.ts) in the MPEG-2 player (StreamXpress).

d) Search for the HbbTV channel on the HbbTV product. If the content of the .ts file can be
correctly displayed on the HbbTV, the connection is successful. Otherwise, check the cable
connection, or refer to the user's manual of the DVB-T modulator for further information.

7. Set up the audio output hardware components as described in the section that addresses
hardware setup.

Related information

Hardware setup with DISC for HbbTV on page 24
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5.2.2 Loading the HbbTV test application
Before starting testing, the HbbTV test application (files at Http_Server_URL/hbbtv_app/) must be
loaded to the HbbTV product under test.

The most efficient way to do that is to enter the debug mode of the HbbTV product and then
start the test application loading manually. Otherwise, an RF-modulated DVB-T transport
stream carrying the test application URL must be fed to the HbbTV product so that the product
can load the application at the URL. Depending on your test hardware setup, you can choose to
load the test application from either your local web server or the DISC server.

Loading from the local HTTP server with the example DVB-T transport stream

If conducting tests with a local HTTP server, you can use the example DVB-T transport stream
we provide in the playback kit package for loading the HbbTV test application from your local
HTTP server.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit .

• All test hardware components are correctly set up.

Procedure

1. Copy the example .ts file (example_mpeg2ts_local_AIT.ts) to your local testing PC.

The example .ts file (example_mpeg2ts_local_AIT.ts) is located in the <kit parent directory>/
Test_Apps/hbbtv_app/data/ directory.

2. Configure the IP address of the HTTP server (Http_Server_URL) to 192.168.0.10.

3. Play the example transport stream (example_mpeg2ts_local_AIT.ts) using an MPEG-2 transport
stream playback software application (for example, DecTek StreamXpress).

4. Select the correct program on the HbbTV product.

The DVB-T stream content is displayed first, and then after a few seconds, the HbbTV test
application is automatically displayed. If the application GUI does not appear, press the red
button on the remote control to manually load the application.

Loading from the app server with the example DVB-T transport stream

If conducting tests with the servers set up by Dolby, you can use the example DVB-T transport
stream we provide in the playback kit package for loading the HbbTV test application from the
app server.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit .

• All test hardware components are correctly set up.

Procedure

1. Download the example .ts file (example_mpeg2ts_streaming_AIT.ts) to your local testing PC from
the web page <kit starting page>/Test_Apps/ on the DISC website (https://
disc.dolbycustomer.com).

2. Play the example transport stream (example_mpeg2ts_streaming_AIT.ts) using an MPEG-2
transport stream playback software application (for example, DecTek StreamXpress).

3. Select the correct program on the HbbTV product.
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The DVB-T stream content is displayed first, and then after a few seconds, the HbbTV test
application is automatically displayed. If the application GUI does not appear, press the red
button on the remote control to manually load the application.

Loading the HbbTV test application with customized DVB-T transport stream

Alternatively, you can create a new transport stream to load the HbbTV test application.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit .

• All test hardware components are correctly set up.

Procedure

1. Create a DVB-T transport stream with an AIT table that carries the URL of the HbbTV test
application.

The DVB-T transport stream must contain an AIT table. In the AIT table, the URL_base line
indicates the HbbTV application URL on the server. In your test, this URL points to where the
HbbTV test application is stored. For example, the HbbTV test application is in the <root
directory>/hbbtv_app/ directory on your local HTTP server with the IP address set to
192.168.0.10. You must set the URL_base to http://192.168.0.10/hbbtv_app/ as indicated in
the following code.

AIT[dvb]:
    table_id_extension: 0x0010   
    common_descriptors:    
    applications:       
      Application:
            organisation_id: 0x00000071
            application_id: 0x0064
            application_control_code: 0x01           
            app_descriptors:               
               TransportProtocolDescriptor:                   
                  protocol_id: 0x0003                   
                  transport_protocol_label: 0x01                   
                  HttpUrl:
                         URL_base: "http://192.168.0.10/hbbtv_app/"                    
   
                         URL_extensions:               
               ApplicationDescriptor:                   
                  application_profiles:                       
                      ApplicationProfile:                           
                          application_profile: 0x0000                           
                          version_major: 0x01                           
                          version_minor: 0x02                           
                          version_micro: 0x01                   
                  service_bound_flag: 0x01                   
                  visibility: 0x03
                  application_priority: 0x01                   
                  transport_protocol_label: "\x01"               
              ApplicationNameDescriptor:                   
                  names:                       
                      AppName:                           
                          ISO_639_language_code: eng
                          application_name: "Dolby BJO TEST HbbTV App."               
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              SimpleAppLocationDescriptor:                   
              initial_path: "index.html"
#    CRC_32: 0x7dd4bba6

2. Send the DVB-T transport stream to the HbbTV product by playing the stream on the local
PC, using the MPEG-2 transport stream playback software application (for example, DecTek
StreamXpress).

3. Select the HbbTV channel on the HbbTV product.

The DVB-T stream content is displayed first, and then after a few seconds, the HbbTV test
application is automatically displayed. If the application GUI does not appear, press the red
button on the remote control to manually load the application.

5.2.3 Test application controls
Operate the test application to perform different types of test cases.

Controls on the test application can be adjusted by:

• Using the arrow keys on the remote control to navigate through test signals, and then
pressing the Ok button to play the selected test signal

• Using the four-color function keys on the remote control

• Using the playback control keys on the remote control to control playback process

GUI overview

All application functions can be managed through the GUI workspace.

Figure 10: Test application GUI

1 Playback control
Press the playback control buttons on the remote control to control playback progress.

2 Audio component
Indicates the audio component (language or codec) available in a test stream. Pressing the
green button on the remote control displays the audio component information. Each
component is numbered (0 or 1) in the GUI. Select a component to play by pressing the
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corresponding number button on the remote control. The component being selected is
highlighted in green.

3 Stream list/output

• This section displays a list of test streams for selection when no test stream is playing.
Test signals are organized in hierarchy. Use the arrow and return keys on the remote
control to navigate through different levels. A selected test stream is underscored.

• After you start playing a test stream, this section shows output information of the
currently playing stream, such as playback status and error messages.

4 Now playing
Displays URL of a currently playing test stream.

5 Display area
Displays the playback information of a currently playing stream.

6 Test signal description
Displays information on a selected test signal, such as bit rate, available audio and video
tracks, purpose of the test signal, and so on.

7 Function buttons

Toggle full screen
During playback of a test stream, press the red button on the controller to display the page
full screen.

Get audio components
Press the green button on the controller to display the audio component available in the
audio component area.

Display output
Press the yellow button on the controller to display the output information.

Display stream info
Press the blue button on the controller to switch on/off display of information on a selected
test stream.

Locating a test signal from the test application GUI

After you have completed the questionnaire from Playback kit Interactive Test Procedure, a
test-case list required for your system is generated. With information shown in the test-case
list, you can locate the correct test signal from the test application GUI for testing.

About this task

The test-case list contains this information: the online delivery format, profile, video codec, and
test-case type.

Figure 11: An example of a test-case list generated in the interactive test procedure
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In the Test case column, the first two digits indicate the test-case type.

Table 5: Test-case type
First two digits Test-case type

01 ChID_2ch

02 ChID_6ch

03 ChID_8ch

04 ChID_6ch_atmos

05 little_endian

06 dual_decoding

07 multi_lang

08 multi_codec

09 multi_av_rate

10 multi_video_rate

11 music

12 crc

13 box

14 codec

15 av_sync

16 av_sync_6ch_atmos

In the test application, test signals are organized by supported features in this structure:

• <Online_delivery_format_profile>

• <Video_codec>

• <Test_case>

You must reference the information indicated in the test-case list to locate a specific test signal
from the test application GUI. For example, to locate the test signal of the first row shown in
this figure, you must follow these steps.

Procedure

1. In the test application GUI, select the correct <Online_delivery_format_profile> (in this case,
DASH_Live).

2. Select the correct <Video_codec> (in this case, H.264).

3. Select the correct <Test_signal> to play (in this case, ChID_2ch).

For inquiring the test case type, see the table Table 5 on page 50.

4. You must repeat steps 1 to 3 to complete all required tests listed for your system
capabilities.

Playing test signals on the HbbTV product

Prerequisites

• The HbbTV product must have access to the test signals.

• If local web server is used, ensure that all test signals have been downloaded and stored
in that server.

Confidential information Test applications

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 50



• If DISC website is used, ensure that the HbbTV product has an Internet connection and is
able to access the DISC website.

• The test application must be successfully loaded to the HbbTV product.

Procedure

1. Load the test application.
The application GUI appears.

2. Navigate to and highlight the test signal you want to play in the test stream list panel by
using the arrow keys on the remote control:

• By default, all available test signals are listed by the test application. you must select
those required ones to play by referencing the resulting page that contains the test-case
list generated by the Playback Kit Interactive Test Procedure.

• Information about the underscored test signal is displayed in the display area.

• You can return to the parent level playlist by pressing the Return key on the remote
control.

3. Play a highlighted test signal by pressing the Ok key on the remote control:

• If playback of a test signal is successful, the Debug panel displays
Connecting...>Buffering...>Playing..., and the video plays back in the window in correct
alignment with the audio.

• If playback of a test signal fails, the Debug panel displays error messages.

Note: Adverse behaviors during playback (such as audible pops, clicks, or muting)
cannot be detected by the test application, and no error indication will display.

Related information

Loading the HbbTV test application on page 46
Locating a test signal from the test application GUI on page 49

Fast forwarding and rewinding

About this task

Procedure

1. Click the fast-forward button on the remote control once to jump forward ten seconds.

2. Click the rewind button on the remote control to jump back ten seconds.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.

Procedure

1. Press the green Get audio component key on the remote control to display any audio
components available in the test stream.

Confidential information Test applications

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 51



Icons indicating audio components appear in the audio component area of the GUI. (Each
icon has an index number underneath.)

2. Press the number key on the remote control to play back the corresponding audio
component.

5.3 Test application for HbbTV 2.0 compliant products
This test application is designed for playing back Dolby Digital Plus bitstreams on HbbTV 2.0-
compliant products.

Note: In this release, use this link https://d9zmmjtv72w5o.cloudfront.net/OnDelKits/DDP/
Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/Start_Here.html for accessing test materials.

5.3.1 Setting up testing infrastructure
To stream test signals from the DISC website to the HbbTV product under test, you must ensure
that the HbbTV product has an Internet connection and is able to access both the DISC website
and the app server hosting the HTML5–based HbbTV test application.

Connecting the HbbTV 2.0 product to the DISC website

Procedure

1. Connect the HbbTV 2.0 product to the Internet. (For the procedure of accessing the Internet,
refer to the user's manual of the HbbTV 2.0 product.)

2. Access streaming.dolby.com with the HbbTV built-in web browser to verify the network
connectivity between the HbbTV 2.0 product and the app server that hosts the HbbTV 2.0
test application.

3. Access the DISC website at https://disc.dolbycustomer.com with the HbbTV built-in web
browser to verify the network connectivity between the HbbTV 2.0 product and the DISC
website that hosts the test signals.

4. Connect a PC to a DVB-T modulator.

The PC and the DVB-T modulator comprise the broadcaster module.

5. Connect the HbbTV to the DVB-T modulator with a coaxial cable.

6. Verify the connection between the HbbTV and the broadcaster module.

a) Download the example .ts file (example_mpeg2ts.ts) to the PC from the web page <kit starting
page>/Test_Apps/HbbTV2_app/data/ on the DISC website (https://disc.dolbycustomer.com).

b) Run the MPEG-2 transport stream player (for example, StreamXpress) on the PC.

c) Open and play the example .ts file (example_mpeg2ts.ts) in the MPEG-2 player (StreamXpress).

d) Search for the HbbTV channel on the HbbTV 2.0 product. If the content of the .ts file can
be correctly displayed on the HbbTV, the connection is successful. Otherwise, check the
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cable connection, or refer to the user's manual of the DVB-T modulator for further
information.

7. Set up the audio output hardware components as described in the section that addresses
hardware setup.

5.3.2 Loading the HbbTV 2.0 test application
Before starting testing, the HbbTV test application must be loaded from the app server (files at
Http_Server_URL/hbbtv2_app/) to the HbbTV 2.0 product under test by using the example DVB-T
transport stream we provide in the playback kit package.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit .

• All test hardware components are correctly set up.

Procedure

1. Download the example .ts file (example_mpeg2ts_streaming_AIT_for_cobalt20.ts) to your local
testing PC from the web page <kit starting page>/Test_Apps/ on the DISC website (https://
disc.dolbycustomer.com).

2. Play the example transport stream (example_mpeg2ts_streaming_AIT_for_cobalt20.ts) using an
MPEG-2 transport stream playback software application (for example, DecTek StreamXpress).

3. Select the correct program on the HbbTV product.

The DVB-T stream content is displayed first, and then after a few seconds, the HbbTV test
application is automatically displayed. If the application GUI does not appear, press the red
button on the remote control to manually load the application.

5.3.3 Test application controls
Operate the test application to perform different types of test cases.

Controls on the test application can be adjusted by:

• Using the arrow keys on the remote control to navigate through test signals, and then
pressing the Ok button to play the selected test signal

• Using the four-color function keys on the remote control

• Using the playback control keys on the remote control to control playback process

GUI overview

All application functions can be managed through the GUI workspace.
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Figure 12: Test application GUI

1 Playback control
Press the playback control buttons on the remote control to control playback progress.

2 Audio component
Indicates the audio component (language or codec) available in a test stream. Pressing the
green button on the remote control displays the audio component information. Each
component is numbered (0 or 1) in the GUI. Select a component to play by pressing the
corresponding number button on the remote control. The component being selected is
highlighted in green.

3 Stream list/output

• This section displays a list of test streams for selection when no test stream is playing.
Test signals are organized in hierarchy. Use the arrow and return keys on the remote
control to navigate through different levels. A selected test stream is underscored.

• After you start playing a test stream, this section shows output information of the
currently playing stream, such as playback status and error messages.

4 Now playing
Displays URL of a currently playing test stream.

5 Display area
Displays the playback information of a currently playing stream.

6 Test signal description
Displays information on a selected test signal, such as bit rate, available audio and video
tracks, purpose of the test signal, and so on.

7 Function buttons

Toggle full screen
During playback of a test stream, press the red button on the controller to display the page
full screen.

Get audio components
Press the green button on the controller to display the audio component available in the
audio component area.
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Display output
Press the yellow button on the controller to display the output information.

Display stream info
Press the blue button on the controller to switch on/off display of information on a selected
test stream.

Playing test signals on the HbbTV 2.0 product

Prerequisites

• The HbbTV 2.0 product must be able to access the DISC website and the test signals.

• The test application must be successfully loaded to the HbbTV product.

Procedure

1. Load the test application.
The application GUI appears.

2. Navigate to and highlight the test signal you want to play in the test stream list panel by
using the arrow keys on the remote control:

• By default, all available test signals are listed by the test application. you must select
those required ones to play by referencing the resulting page that contains the test-case
list generated by the Playback Kit Interactive Test Procedure.

• Information about the underscored test signal is displayed in the display area.

• You can return to the parent level playlist by pressing the Return key on the remote
control.

3. Play a highlighted test signal by pressing the Ok key on the remote control:

• If playback of a test signal is successful, the Debug panel displays
Connecting...>Buffering...>Playing..., and the video plays back in the window in correct
alignment with the audio.

• If playback of a test signal fails, the Debug panel displays error messages.

Note: Adverse behaviors during playback (such as audible pops, clicks, or muting)
cannot be detected by the test application, and no error indication will display.

Fast forwarding and rewinding

About this task

Procedure

1. Click the fast-forward button on the remote control once to jump forward ten seconds.

2. Click the rewind button on the remote control to jump back ten seconds.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.

Procedure

1. Press the green Get audio component key on the remote control to display any audio
components available in the test stream.
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Icons indicating audio components appear in the audio component area of the GUI. (Each
icon has an index number underneath.)

2. Press the number key on the remote control to play back the corresponding audio
component.

5.4 Test application for Xbox 360
This test application is designed for playing back Dolby Digital Plus bitstreams on the Xbox 360.

Note: All of the procedures depicted in this section can only be performed on a
development version of an Xbox 360. Do not try them on a retail version Xbox 360.

5.4.1 Preparing the development environment for Xbox 360
To deploy the Dolby test application for the Xbox 360 platform, you must have the Xbox 360
and PC on the same network, and prepare the development environment.

Software applications referred in this section are available for download from https://
developer.xboxlive.com/. You must also have an account to access this page.

1. Installing the Xbox 360 XDK on a PC

2. Flashing Xbox 360 firmware

3. Creating a user profile on Xbox 360

4. Adding Xbox 360 to the Microsoft Visual Studio environment

Installing the Xbox 360 XDK on a PC

Prerequisites

• You must have an account to access the https://developer.xboxlive.com/ page.

• The PC for development runs the Windows 7 operation system.

• Microsoft Visual Studio 2010 must be installed on the PC.

Note: Reboot the PC if required during the installation process.

Procedure

1. Uninstall all Silverlight components from the development PC.

Go to Control Panel > Uninstall a program, and uninstalled all applications with Silverlight
in the names. Silverlight version 5 or later may interfere with the installation process.

2. Install Silverlight 3 Development Runtime.

Silverlight 3 Development Runtime cannot be installed from Silverlight 3 development tools;
separate installer files are required. Use version 3.0.50106.0 or later. It is available for
download from http://go.microsoft.com.

3. Install Silverlight 3 SDK.

Xbox ADK requires some libraries from Silverlight 3. Use version 3.0.40818.0 or later. It is
available for download from http://www.microsoft.com/.

4. Install Silverlight 4 Development Runtime.

5. Disable Silverlight 4 Development Runtime automatic updates by navigating to the Windows
Start > Microsoft Silverlight > Updates tab, and checking Never check for updates.
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Note: This must be done immediately after the installation of Silverlight 4 Development
Runtime. If Silverlight Development Runtime updates to version 5 or later, you may need
to perform this procedure again.

6. Install Silverlight 4 SDK.

It is available for download from http://www.microsoft.com/.

7. Install Silverlight 4 development tools.

It is available for download from http://www.microsoft.com/.

8. Install Xbox XDK. Use version XDKSetupXenon21250.7.exe or later.
The installed XDK is visible as SDK on your PC.

9. Install Xbox ADK. Use version Xbox360ADK_April_2012.msi or later.

10. Follow the instructions in the installation wizard, and choose the options best suited for
your working environment.

Flashing Xbox 360 firmware

To make the Xbox 360 a viable platform for development, you must prepare it by flashing its
firmware.

Prerequisites
The Xbox 360 under test must be a development version.

Procedure

1. Connect a TV to the Xbox 360 console with an HDMI cable, and turn them both on.

2. Connect the game controller to the Xbox 360 console.

3. Connect the Xbox and the development PC to the same network.

IP addresses should be allocated for both the Xbox and the PC with the DHCP service.
Otherwise, you must manually set IP addresses for both machines. Information regarding
the steps necessary to set an IP address is not within the scope of this document.

4. Locate the recovery tool (use the version XDKRecoveryXenon21250.2.exe or later), and launch it
on the PC.

A UI appears to assist you through the process.

5. Click Next until you see the page that requires the Xbox 360 IP address.

6. Enter the Xbox 360 IP address in the Destination Xbox 360 Development Kit field.

The Xbox 360 IP address can be found in the upper-right corner of the Xbox 360 GUI
displayed on the TV.

7. Click Next.

This starts the connection between the PC and the Xbox 360. The process take 30 seconds or
more, during which the Xbox 360 GUI on the TV may turn off for a short time, and the
recovery tool may seem to stop responding.

When successfully connected:

• The Xbox 360 displays this on the TV screen:

Updating…
Starting Recovery…
Do not power off or reboot!
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• The recovery tool prompts the Reset Xbox 360 Development Kit Settings to Default
States page.

8. On the PC, select the current version (for example, 16197 - Current Production Flash) from the
Select a system version to install drop-down list in the Reset Xbox 360 Development Kit
Settings to Default States page.

9. Check all check boxes in the Reset Xbox 360 Development Kit Settings to Default States
page, including:

• Reset Xbox 360 Development Kit settings to default states

• Format console dard drive

• Install optional files (content and samples)

• Install System Extended Packages (enhanced experience)

10. Click Next.

1. During the updating process:

• The Xbox 360 displays this on the TV screen:

Updating… 
E\samples…
Do not power off or reboot!

• The recovery tool display a progress bar indicating the update progress.

2. When the update is complete, the Xbox 360 console will reboot and a simple setup wizard
then displays.

3. Click Finish on the PC.

11. Choose language (English) with the A button (green button) on the Xbox 360 controller.

Creating a user profile on Xbox 360

After flashing the Xbox 360, you must re-create a user profile.

Prerequisites
The Xbox 360 is connected into the Internet.

Procedure

1. Navigate from the Xbox 360 main screen to Tools > Xbox Live Tools > Create a new profile
by using the game controller.

Key instruction appears in the lower-left corner of the Xbox UI on the TV screen.

2. Select or create an Xbox Gamertag, and then click OK.

3. Select an avatar.

4. Select Yes to make this the default profile.

5. Select Yes to make this profile Xbox Live enabled.

6. Leave the pass code empty.

7. Set your country to US.

8. Set the subscription to gold.

Results
The screen shows this message:

Creating user profile…

Confidential information Test applications

Dolby Digital Plus online delivery playback Version 1.4.1 System Testing Help

31 July 2018 58



The progress takes approximately a minute.

Adding Xbox 360 to the Microsoft Visual Studio environment

To make the Xbox 360 available in Microsoft Visual Studio, you must use the Xbox 360
Neighborhood tool.

About this task

Note: If the IP address of the Xbox 360 under test is assigned by a DHCP server, it can be
changed every time the Xbox 360 reboots. In such a case, you must repeat this procedure
to make the Xbox 360 available in Microsoft Visual Studio. Otherwise, you may set the
static IP address for the Xbox 360.

Procedure

1. Launch the Xbox 360 Neighborhood tool by clicking on your development PC Menu Start >
All Programs > Microsoft Xbox 360 SDK > Xbox 360 Neighborhood.

2. Run the Add Xbox 360.
The Add New Xbox 360 Development Kit window appears.

3. Follow the instruction to complete these steps:

a) Enter the IP address of the Xbox 360 into the field.

The Xbox 360 IP address can be found in the upper-right corner of the Xbox 360 GUI
displayed on the TV.

b) Select the option to make the connected Xbox 360 the default.

The Xbox 360 appears as an icon on the Xbox 360 Neighborhood tool.

5.4.2 Deploying the test application project
This test application is supplied as a Visual Studio solution in the Dolby Digital Plus Online
Delivery Kit. To run tests with the test application, you must deploy the entire solution for your
Xbox 360.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit .

• You must have the Xbox 360 development environment prepared.

• The playlist file has been prepared as described in the section that addresses how to prepare
a test signal list.

Procedure

1. Download or copy the Xbox360_app.zip file to an appropriate directory on your development
PC.

If you have had the kit downloaded and unpacked on your local PC, locate the .zip file in the
<kit parent directory>/Test_Apps/ directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Unzip the file Xbox360_app.zip, and make sure the unzipped folder Xbox360_app contains an .sln
file and a subfolder.

3. Open the .sln file with Microsoft Visual Studio.
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In Microsoft Visual Studio 2010, click File > Open > Project/Solution, and select the .sln file.

4. Build and deploy the test application for the Xbox 360.

a) In Microsoft Visual Studio 2010, click BUILD > Build Solution.

b) Click BUILD > Deploy Solution .

What to do next

• The test application must be launched from Visual Studio 2010 by using the Start
Debugging function.

5.4.3 Setting up the testing infrastructure
To run tests with the test application, you must set up the testing infrastructure best suited for
your environment. You can choose to connect your device under test to either to a local web
server or to the DISC website.

Connecting the product under test to a local HTTP server

If you are accessing the Internet from behind a firewall or if you do not have a fast Internet
connection, set up your playback device under test as described in this section.

About this task

To simulate a server/client media streaming process, the device under test must be connected
to a local HTTP server that hosts the test signals.

Procedure

1. Set up hardware components as described in the section that addresses hardware setup
with a local HTTP server.

2. Download the entire playback kit onto your local HTTP server from the DISC website (https://
disc.dolbycustomer.com), and unpack it to an appropriate directory.

3. Configure the IP address of the local HTTP server.

4. Assign a valid IP address for the Xbox 360 under test. (Usually, the IP is set automatically. For
the procedure of setting the IP address for your device under test, refer to the user's manual
that addresses the device under test.)

5. Verify the connection by accessing the Start_Here.html page of the kit in the device under test
built-in web browser.

Related information

Hardware setup with a local web server for MPEG-DASH and HTTP Live Streaming on page 19

Connecting the device under test to the DISC website

If you have access to an Internet connection with adequate bandwidth for streaming test signal
to your playback product, set up your testing infrastructure as described in this section.

About this task

To stream test signals from the DISC website to the Xbox 360 under test, you must ensure that
the device under test has an Internet connection and is able to access the DISC website.
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Procedure

1. Set up hardware components as described in the section that addresses hardware setup
with the DISC website.

2. Connect the device under test into Internet. (For the procedure that addresses accessing the
Internet, refer to the user's manual of the device under test.)

3. Verify the connection by accessing the DISC website at https://disc.dolbycustomer.com in
the Xbox 360 built-in web browser.

Related information

Hardware setup with DISC for MPEG-DASH and HTTP Live Streaming on page 22

5.4.4 Test application controls
Operate the test application to perform different types of test cases.

GUI controls on the test application can be adjusted by:

1. Pressing the B button on the game controller to display the green outline of the area
currently active in the application GUI.

2. Using the analog sticks on the game controller to navigate around areas.

3. Pressing the A button on the game controller to choose an area as the active area.

4. Using the analog sticks on the game controller to focus on the desired function in the GUI,
and then pressing the A button on the game controller to execute.

GUI overview

All application functions can be managed through the GUI workspace.
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Figure 13: Test application GUI

1 Test list
Displays a list of test signals. Test signals are organized in a hierarchical structure.

2 Audio component
Displays audio tracks with different encodings presented in a test stream.

3 Information
Displays information about a currently playing test signal, such as bit rate, available audio
and video tracks, purpose of the test signal, and so on.

4 Playback window
Displays video content of a currently playing test signal.

5 Menu
Contains functions such as Exit, Back, Load Single URL, and Load Playlist from HTTP
Server.

6 URL information
Displays the URL information of the currently selected test signal.

7 Output
Displays information, such as playback status, bit-rate information, error messages, and so
on.

8 Information
Click this key to display or hide information on a selected test signal, such as bit rate,
available audio and video tracks, purpose of the test signal, and so on.

9 Full screen
Click this key to play back video content in full-screen mode.
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10 Playback control
Use these keys to control the playback process. (From left to right, these keys include
previous, rewind ten seconds, play, pause, stop, fast forward ten seconds, and next.)

11 Playback slider
Use this slider to seek to a desired position in a stream for playback.

Locating a test signal from the test application GUI

After you have completed the questionnaire from Playback kit Interactive Test Procedure, a
test-case list required for your system is generated. With information shown in the test-case
list, you can locate the correct test signal from the test application GUI for testing.

About this task

The test-case list contains this information: the online delivery format, profile, video codec, and
test-case type.

Figure 14: An example of a test-case list generated in the interactive test procedure

In the Test case column, the first two digits indicate the test-case type.

Table 6: Test-case type
First two digits Test-case type

01 ChID_2ch

02 ChID_6ch

03 ChID_8ch

04 ChID_6ch_atmos

05 little_endian

06 dual_decoding

07 multi_lang

08 multi_codec

09 multi_av_rate

10 multi_video_rate

11 music

12 crc

13 box

14 codec

15 av_sync

16 av_sync_6ch_atmos
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In the test application, test signals are organized by supported features in this structure:

• <Online_delivery_format_profile>

• <Video_codec>

• <Test_case>

You must reference the information indicated in the test-case list to locate a specific test signal
from the test application GUI. For example, to locate the test signal of the first row shown in
this figure, you must follow these steps.

Procedure

1. In the test application GUI, select the correct <Online_delivery_format_profile> (in this case,
DASH_Live).

2. Select the correct <Video_codec> (in this case, H.264).

3. Select the correct <Test_signal> to play (in this case, ChID_2ch).

For inquiring the test case type, see the table Table 6 on page 63.

4. You must repeat steps 1 to 3 to complete all required tests listed for your system
capabilities.

Playing test signals from the DISC website on the Xbox 360

The built-in playlist points to all available test signals located on the DISC website. You can
follow the instructions in this section to perform testing if you stream test signals from the
DISC website.

Prerequisites

• The device under test must have access to the test signals.

• The test application has been successfully deployed.

About this task
If you choose to set up a local IIS server for testing, you must ensure that all test signals have
been downloaded and stored in that server, generate a playlist that contains the IIS server URL
with the Playback Kit Interactive Test Procedure, and use the Load Playlist from HTTP Server
function to load the test signals.

Procedure

1. Launch the test application from Visual Studio 2010 by using the DEBUG > Start Debugging
function (or pressing <F5>):

• The application GUI appears on the TV screen.

• All available test signals appear in the Playlist panel. Test signals are organized by
variations.

2. Navigate to the test signal you want to play in the Playlist panel by selecting its variations:

• By default, all available test signals are listed by the test application. you must select
those required ones to play by referencing the resulting page that contains the test-case
list generated by the Playback Kit Interactive Test Procedure.

• Highlighting a test signal displays information about the signal. You can toggle the
information on and off by clicking the Info key on the bottom.
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• You can return to the parent-level playlist by selecting Back at the top of the Playlist
panel.

3. Play a test signal by pressing the A key on the game controller:

• If playback of a test signal is successful, the Output panel displays Opening > bitrate
changed: # Kbps>Playing, and the video plays back in the window in correct alignment
with the audio.

• If playback of a test signal fails, the Output panel displays error messages.

Note: Adverse behaviors during playback (such as audible pops, clicks, or muting)
cannot be detected by the test application, and no error indication will display.

• If network bandwidth fluctuates during playback, Current bitrate: # kbps changes to
indicate that audio track switching is occurring to accommodate to current bandwidth.

Related information

Deploying the test application project on page 59
Accessing the test materials on page 8
Locating a test signal from the test application GUI on page 49

Playing a test signal by specifying a URL

It is also possible to play a test signal by pointing at its URL.

About this task

Note: You must have a physical keyboard to use this function.

Procedure

1. Go to the Menu, and select Load Single URL.
A text box appears.

2. Enter the URL of an individual test stream in the text box by using a physical keyboard.

3. Select the Load button to play the test signal.

If an incorrect URL is entered, clicking the Load button returns the application to its main
view.

If successfully loaded, the test signal starts playing back.

Playing test signals by loading a playlist from an HTTP server

With an HTTP server, you can use the Load Playlist from HTTP Server function to import a
playlist that contains test cases suited for your system capabilities only.

About this task
By default, all available test signals are shown in the test application. If you want the test
application to list only those required test signals for your system, you must follow the
procedure described in this section. This function has no regard for the location where the test
signals are stored.

Procedure

1. Generate the c_playlist.zip file from Playback Kit Interactive Test Procedure.
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For detailed information, refer to the section that addresses how to use Playback Kit
Interactive Test Procedure.

2. Download and unzip the c_playlist.zip to the HTTP server.

3. Launch the test application.

4. Go to the Menu, and select Load Playlist from HTTP Server.
A text box appears in a new page.

5. Enter the URL of the unzipped c_playlist folder in the text box.

6. Select the Load button to import the test-case list to the test application.

If an incorrect URL is entered, clicking the Load button returns the application to its main
view.

If successfully loaded, the test-case list appears in the Testlist panel.

7. Play test signals.

Fast forwarding and rewinding

About this task
A playback slider is available on the test application GUI. During playback, you can activate this
area, and use the analog stick to seek to a specific position. Alternatively, you can use the
playback control keys to fast forward or rewind.

Procedure

1. Click the +10sec button on the GUI once to jump forward ten seconds.

2. Click the -10sec button on the GUI once to jump back ten seconds.

Switching between different audio tracks

For test cases such as multiple languages, you must switch between different audio tracks.

About this task

Procedure

1. Display available audio components the by selecting the AudioComponent tab.

2. Make sure that the track information listed in the AudioComponent panel matches what is
described in the Information box.

The track information listed in the AudioComponent panel is extracted directly from the test
signal. If this information does not match what is described in the Information box, the test
signal is not correctly decoded.

3. Select the audio track to start playback.
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5.5 Test application for an HTML5-supported web
browser
This test application verifies that a web browser that supports HTML5 is able to play back Dolby
Digital Plus bitstreams.

When playing back a test signal in a web browser that does not support Dolby Digital Plus
correctly, the video part plays properly but the audio part is muted.

Note: Currently, this test application supports these web browsers only: Safari 9 (El
Capitan) (Mac OS X 10.11) and Microsoft Edge.

5.5.1 Accessing the test application
The test application is a web-based video player that can be opened in any supported web
browser.

Procedure

Access the test application at https://d9zmmjtv72w5o.cloudfront.net/OnDelKits/DDP/
Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/Test_Apps/HTML5/index.html in a web browser.

5.5.2 GUI overview
All application functions can be managed through the GUI workspace.
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Figure 15: Test application GUI

1 Playlist
Displays a list of test signals. Test signals are organized in a hierarchy.

2 Media component
Displays audio and video tracks with different encodings presented in a test stream. This
tab works for MPEG-DASH test streams only.

3 Information box
Displays information about a selected test signal, such as bit rate, available audio and video
tracks, purpose of the test signal, and so on.

4 Playback window
Displays video content of a currently playing test signal.

5 Menu
Contains options: Load a signal, About, and Back.

6 URL information
Displays the URL information of the currently playing test signal.

7 Output
Displays information such as playback status, bit-rate information, error messages, and so
on.

8 Information button
Click this key to display information about a selected test signal, such as bit rate, available
audio and video tracks, purpose of the test signal, and so on.

9 Full screen
Click this key to play back video content in full-screen mode.

10 Playback control
Use these keys to control the playback process. (From left to right, keys include previous,
rewind, play, pause, stop, fast forward, and next.)

11 Loop on/off
With the loop function on, the test application plays back each test signal continuously one
after another until it finishes playing the final available test signal.
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5.5.3 Locating a test signal from the test application GUI
After you have completed the questionnaire from Playback kit Interactive Test Procedure, a
test-case list required for your system is generated. With information shown in the test-case
list, you can locate the correct test signal from the test application GUI for testing.

About this task

The test-case list contains this information: the online delivery format, profile, video codec, and
test-case type.

Figure 16: An example of a test-case list generated in the interactive test procedure

In the Test case column, the first two digits indicate the test-case type.

Table 7: Test-case type
First two digits Test-case type

01 ChID_2ch

02 ChID_6ch

03 ChID_8ch

04 ChID_6ch_atmos

05 little_endian

06 dual_decoding

07 multi_lang

08 multi_codec

09 multi_av_rate

10 multi_video_rate

11 music

12 crc

13 box

14 codec

15 av_sync

16 av_sync_6ch_atmos

In the test application, test signals are organized by supported features in this structure:

• <Online_delivery_format_profile>

• <Video_codec>
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• <Test_case>

You must reference the information indicated in the test-case list to locate a specific test signal
from the test application GUI. For example, to locate the test signal of the first row shown in
this figure, you must follow these steps.

Procedure

1. In the test application GUI, select the correct <Online_delivery_format_profile> (in this case,
DASH_Live).

2. Select the correct <Video_codec> (in this case, H.264).

3. Select the correct <Test_signal> to play (in this case, ChID_2ch).

For inquiring the test case type, see the table Table 7 on page 69.

4. You must repeat steps 1 to 3 to complete all required tests listed for your system
capabilities.

5.5.4 Playing test signals
Test signals are streamed from the DISC server.

All available test signals are listed in the Playlist. You can play a test signal by single-clicking on
it. Alternatively, you can use the Loop on/off function to play all of the test signals one after
another automatically starting from the currently playing signal.

Playing back status is indicated in the Output panel. When encountering issues during
playback, error messages are displayed in the Output panel. For detailed information about
possible error messages, see http://www.w3.org/TR/html5/embedded-content-0.html#error-
codes.

Playing a test signal by specifying a URL

It is also possible to play a test signal by entering its URL.

Procedure

1. Go to the Menu, and select Load Single URL.

2. Enter the URL of an individual test stream in the address bar.

3. Select the Load button to play the test signal.

If an incorrect URL is entered, clicking the Load button returns the application to its main
view.

If successfully loaded, the test signal starts playing back.

5.5.5 Fast forwarding and rewinding

Procedure

1. Click the fast-forward button on the GUI once to jump forward ten seconds.

2. Click the rewind button on the GUI to jump back ten seconds.

5.5.6 Switching between different audio tracks
For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.
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Procedure

1. Start playing back a test signal by single-clicking on it.

2. Display available audio components the by selecting the MediaComponent tab.

Audio track information will appear in the MediaComponent tab during playback.

3. Make sure that the track information listed in the MediaComponent panel matches what is
described in the Information box.

The track information listed in the MediaComponent panel is extracted directly from the
test signal. If this information does not match what is described in the Information box, the
test signal is not correctly decoded.

4. Switch between available audio tracks during playback.

Figure 17: Audio track switching

For an audio track with multiple bit rates, switch off the ABR button, and choose which bit
rate to play back manually.

5.6 Test application for Android TV
Dolby provides test applications for playing back Dolby Digital Plus with Dolby Atmos content
bitstreams on an Android TV platform.

In this documentation, Google Nexus Player is used as an example to show how to install the
Dolby test application on an Android TV.

Note: In this release, use https://d9zmmjtv72w5o.cloudfront.net/OnDelKits/DDP/
Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/Test_Apps/Test_Apps.html for accessing test
materials.

Note: Unless otherwise stated, all PC-related operations described in this instruction are
performed on a PC running Windows.

5.6.1 Preparing the development environment for Android TV
To install the Dolby test application onto an Android TV, you must have the Android TV and a
testing PC connected, and the development environment prepared.

Prerequisites

These items are required:
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• The Android TV. (In this document, we use Nexus Player as the example device.)

• A display device (for example, a TV).

• A Windows PC.

• A USB cable for connecting the Android TV to the PC.

Procedure

1. Connect the Nexus Player to a testing PC with a USB cable.

2. Connect the Nexus Player to a display with an HDMI cable.

This display is for presenting the Android TV output.

3. Enable the Nexus Player for development.

For detailed information about enabling a device for development, refer to its user's manual:

a) For the Nexus Player, use its remote control to navigate to Settings > Preferences >
Developer options > Debugging > USB debugging, and select On.

4. Install USB drivers for ADB onto the PC.

For detailed information about USB driver installation, see http://developer.android.com/
tools/device.html.

5. Install the ADB tool on the PC.

For information on how to install the ADB tool, see http://developer.android.com/tools.

6. Add ADB to the PATH system variable:

a) For a Windows 7 system, navigate to Start > Computer > Properties > Advanced system
settings > Advanced tab > Environment Variables.

b) Under the System variables section, locate Path, click on it, and click Edit.

c) In the Edit System Variable window, add the ADB installation path (for example, C:\Users
\AppData\Local\Android\) to the Variable value text box, separated by semicolons from
other path variables.

These steps enable Windows to locate the ADB executable when it is required.

7. Verify that the ADB tool is properly installed by running this command in a command-line
prompt window on the PC.

adb

5.6.2 Installing the test application onto a Nexus Player
Install the Dolby test application onto the Nexus Player by using a Windows PC.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• The development mode has been enabled for the Nexus Player.

• ADB tool has been installed on the Windows PC.

• The Nexus Player is connected to a display device (for example, a TV).

About this task
The Dolby test application is not available from the Google shop; you must follow the steps
described in this section for installation.
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Procedure

1. Download or copy the AndroidTV_app.zip file to an appropriate directory on the PC.

If you have had the kit downloaded and unpacked on your local PC, locate the .zip file in the
<kit parent directory>/Test_Apps/AndroidTV/ directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/AndroidTV/ on
the DISC website (https://disc.dolbycustomer.com).

2. Unzip the file AndroidTV_app.zip, and make sure the unzipped folder AndroidTV_app contains a
AndroidTV.apk file.

3. Connect the Nexus Player to the PC with a USB cable.

4. Open a command-line prompt window from the PC, and run this command from under the
AndroidTV_app folder.

adb install AndroidTV.apk

After the installation has completed, the test application icon will appear on the main page
of the Nexus Player. If the icon is not displayed on the main page, find it in Settings >
Device > Apps > Downloaded apps.
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5.6.3 Preparing a test signal list for the test application
You can first screen out the relevant test cases for your system by using the interactive test
procedure, and then manually provide the test application with a list of the selected test signals
and their URLs so that the test application is able to locate those test signals for playback.

Procedure

1. Log in to the DISC website at https://disc.dolbycustomer.com.

2. Navigate to the Dolby Digital Plus Online Delivery Kit , and within the kit, click Interactive
Test Procedure.

3. Complete the entire questionnaire of the interactive test procedure, and then click Done.

One step of the questionnaire requires information about the directory where the test
signals are stored. Choose the correct location, Local server or DISC website. If Local server
is selected, enter the path information in the text box as required.
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A test-case list is generated and appears in a new page, with the required and recommended
tests for your system. You must complete all required tests listed for your system
configuration.

4. Click Settings , and then Download playlists, to save a c_playlist.zip file to your local disk.

This playlist file contains the URLs to the required test signals.

5. Unpack the c_playlist.zip file.

This unzipped folder will be used later to import the test-case list to the test application.

6. To generate a new playlist for another set of test signals, repeat steps 3 to 5.

Related information

Testing with the interactive procedure on page 27

5.6.4 Copying the playlist to the Nexus Player or a local web server
You can copy the playlist that contains the URLs to the required test signals to either the Nexus
Player or a local web server for playback.

Prerequisites

• Hardware components are connected correctly.

• ADB tool has been installed on the Windows PC.

Procedure

1. Copy the playlist to the Nexus Player.

a) Open a command-line window from the PC, and run this command from under the
c_playlist folder.

adb push ott_app_playlists.xml /sdcard/Movies/

adb push Playlist /sdcard/Movies/

The unpacked c_playlist folder contains the master playlist file ott_app_playlists.xml and a
folder named Playlist. The /sdcard/Movies/ folder on the Nexus Player device is used as the
default location for storing the playlist. You can also store the playlist in other folders on
the device.

b) Check the ADB log to ensure that no errors are reported.

2. Copy the unpacked c_playlist folder to a local web server.

You can also use a local web server for hosting the playlist (for example, http://192.168.1.200/
c_playlist/ott_app_playlists.xml).

5.6.5 Test application controls
Operate the test application to perform different types of test cases. Controls on the test
application can be adjusted by using the remote control.

Loading the playlist

Choose a playlist for playback.
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Prerequisites

• The Nexus Player is connected to a TV.

• The Nexus Player has an Internet connection and is able to access the DISC website.

About this task

A default playlist contains all of the test signals Dolby designs for all use cases. A customized
playlist generated through using the Interactive Test Procedure contains test signals that are
required for your system only. Depending on your test scheme, the playlist can be placed on the
Android TV device or on a local web server, or it can be accessed directly from Dolby web server.

Procedure

1. Start the test application from the Nexus Player GUI.

 

 

2. Allow the test application to access files on the Nexus Player device.

This window pops up the first time you run the test application. Choose Allow.

 

 

3. Select a playlist by going to Settings > Playlist Preference and checking one of the options
shown in this screen.
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To use the second option, you must first copy the playlist to the /sdcard/Movies/ folder on the
Nexus Player device as described in Copying the playlist to the Nexus Player or a local web
server .

4. Enter the playlist URL by going to Settings > Enter Playlist URL.

You must specify the full file path to the master playlist file (for example, http://192.168.1.200/
c_playlist/ott_app_playlists.xml).

Perform this step only if you have chosen Customized Playlist on User-Specified Server or
Customized Playlist in User-Specified Local Folder in the preceding step.
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5. To switch to another playlist file, you must first clear the cached playlist data. Perform this
step before loading a different playlist than the one used previously:

a) Quit the test application.

b) From the Nexus Player main GUI, select Settings  > Apps > Downloaded apps >

Dolby Android TV > Clear data.

6. Restart the test application.

The test signals referenced in the chosen playlist appear in the main view of the test
application.

Related information

Copying the playlist to the Nexus Player or a local web server on page 75

Playing test signals on the Android TV

Play back test signals by using the Dolby Android TV test application.

Prerequisites

• The playlist been loaded to the test application.

Procedure

1. Start the test application.

The application GUI appears.
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Figure 18: Selecting the online delivery format

2. Select the online delivery format of the test signals.

Available test signals appear on the right-hand side.

3. Select a test signal.

Navigate through the available test signals, and select one to show the test signal
description information.

4. Select PLAY NOW on the top of the test signal description page to start playback.
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Fast forwarding and rewinding

Procedure

1. Click the fast-forward button on the GUI once to jump forward ten seconds.

2. Click the rewind button on the GUI to jump back ten seconds.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, switch between and play back
different audio tracks.

Procedure

1. To show available variant tracks, select the information icon  during playback.

• For multiple-codec test signals, codec options DD+ and AAC appear under the playback
slider.

• For multiple-language test signals, language options En and Fr appear under the playback
slider.

• Otherwise, message appears reading Only one audio track is available.

 

 

2. Select the audio track you want to play back.

5.7 Test applications for Apple TV
Two versions of test applications (Apple Television Markup Language [TVML] and Apple Swift)
are designed for playing back Dolby Digital Plus bitstreams on Apple TV.

5.7.1 About TVML and Swift versions
Both the TVML and Swift versions of the test applications are supplied within the Dolby Digital
Plus Online Delivery Kit in the form of source code.

For the purpose of playing back Dolby Digital Plus bitstreams, build and deploy either version on
an Apple TV directly. They are functionally the same in terms of supporting playback of Dolby
Digital Plus.

For developing your own player application that supports Dolby Digital Plus, use either the
TVML or Swift version as sample code, and integrate into your code the version that best suits
your needs.
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5.7.2 Setting up the testing infrastructure
To run tests with the test application, you must set up the testing infrastructure.

Procedure

1. Connect an Apple laptop to the Apple TV with a USB Type-C cable.

This connection is used for deploying the test application to the Apple TV.

Figure 19: Testing infrastructure for Apple TV
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2. Connect the Apple TV to an A/V receiver with an HDMI interface.

A TV display and multiple-channel speakers (or headphones) can be connected to the A/V
receiver.

3. Connect the Apple TV to the Internet.

This can be a wireless connection. Refer to the Apple TV user's manual of the Apple TV for
more information on connecting to the Internet.)

5.7.3 Deploying the test application on an Apple TV
Deploy the test application on an Apple TV for running tests. This is the same for both the TVML
and Swift versions of the test application.

Prerequisites

• You must have an Apple laptop with Xcode installed.

• Ensure that the Apple TV is connected to the Apple laptop properly.

• Ensure that you are using the correct versions of Xcode, tvOS, and macOS. Update them as
needed:

• Xcode 8.1 Build 8B62

• tvOS 10.0.1 Build 14U71 (To update the tvOS, you need iTunes 12.5.3.)

• macOS Sierra 10.12.1 Build 16B2657

Procedure

1. Download or copy the test application .zip file (either AppleTV_tvml_app.zip or
AppleTV_swift_app.zip) to an appropriate directory on your Apple laptop.
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If you have had the kit downloaded and unpacked on your Apple laptop, locate the .zip file in
the <kit parent directory>/Test_Apps/ directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Extract the file (for example, AppleTV_tvml_app.zip), and make sure the folder contains
an .xcodeproj file.

3. Launch Xcode, and load the project file for the Apple TV test application.

In the Xcode UI, go to File > Open and open the project file .xcodeproj.

4. Select Apple TV as the target device for deployment.

If the Apple TV is switched on and connected to the Apple laptop properly, it can be detected
by Xcode automatically.

5. Start deploying by either clicking on the triangle button or selecting Product > Run.

Results
The test application automatically launches on the Apple TV.

5.7.4 Controls for the TVML version test application
Operate the test application to perform different types of test cases.

Controls on the test application can be adjusted by using the track pad on the Apple TV remote.

GUI overview

All application functions can be managed through the GUI workspace.

With the application launched, three pages display. Swipe your finger on the track pad to switch
focus.
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Test cases
This page lists all of the test signals that are required to run.

About
This page displays version information about the test application.

URL entering
This page allows you to play a test stream by entering its URL.

Playing test signals

Test signals are streamed from the DISC server. All test signals listed in the Test Cases page are
required for verifying the capability of handling Dolby technology.

Enter the Test Cases page by pressing the track pad. Swipe left, right, up, or down to select a
test signal to play. All test signals must be played.

Figure 20: Selecting a test signal
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Alternatively, you can play a test signal by entering its URL in the URL entering page. This is
useful when you play a streaming test signal that is hosted on a different server than the DISC.

During playback of a test signal, swipe down from the top edge of your track pad to access the
option bar. The Info option displays description of the currently playing test signal, including bit
rate, available audio and video tracks, purpose of the test signal, and so on.

To return to the test signal selection page, press the MENU button on the remote control.

Fast forwarding and rewinding

Procedure

1. Click the right edge on the track pad to fast forward.

2. Click the left edge on the track pad to rewind.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.

Procedure

1. During playback of a test signal, swipe down from the top edge of your track pad to access
the option bar.

2. Select the Audio option.
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Figure 21: Switching audio tracks

3. Select the audio track you want to play back.

The selected track has a tick next to it.

5.7.5 Controls for the Swift version test application
Operate the test application to perform different types of test cases.

Controls on the test application can be adjusted by using the track pad on the Apple TV remote.

GUI overview

All application functions can be managed through the GUI workspace.

With the application launched, the entry page displays API modules on the menu bar.
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Six API modules are available for testing. Among the six APIs, AVPlayer is the only one that
supports playback of both audio and video by itself.

AVPlayer
This item calls the AVPlayer API, which supports HTTP Live Streaming and MP4 formats.

AudioUnitPlayer
This item calls the AudioUnit and Audio File Service APIs, which support elementary
stream and MP4 format.

AUGraphPlayer
This item calls the Audio Processing Graph API, which supports elementary stream and MP4
format.

AudioEngine
This item calls the AVAudioEngine API, which supports elementary stream and MP4 format.

AVAudioPlayer
This item calls the AVAudioPlayer API, which supports elementary stream and MP4 format.

AudioQueuePlayer
This item calls the Audio Queue API, which supports elementary stream and MP4 format.

Playing test signals

Test signals are streamed from the DISC server. All test signals listed under an API module are
required for verifying its capability of handling Dolby technology.

Procedure

1. Launch the test application by pressing the center of the track pad.

2. With the menu bar on, swipe your finger left or right on the track pad to switch focus on the
API modules.

Not all of the APIs are able to be displayed at the same time due to the width of a screen.

3. With one API module highlighted, swipe your finger down to access the test signals.

4. Swipe left, right, up, or down to select a test signal to play.

Figure 22: Selecting a test signal

5. With a test signal highlighted, press the play/pause button on the track pad to start playing.
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All test signals must be played.

Test signals for the AVPlayer API module play back with video content. Test signals are
audio-only content for other API modules.

6. To return to the test signal selection page, press the MENU button on the remote control.

Fast forwarding and rewinding

Only test signals for the AVPlayer API module support this function.

Procedure

1. Click the right edge on the track pad to fast forward.

2. Click the left edge on the track pad to rewind.

Switching between different audio tracks

For test cases such as multiple languages and multiple codecs, you must switch between
different audio tracks.

About this task
Only test signals for the AVPlayer API module support this function.

Procedure

1. During playback of a test signal, swipe down from the top edge of your track pad to access
the option bar.

2. Select the Audio option.

Figure 23: Switching audio tracks

3. Select the audio track you want to play back.

The selected track has a tick next to it.

5.8 Test application for Roku TV
This test application is designed for playing back Dolby Digital Plus bitstreams on Roku TV.
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5.8.1 Preparing the development environment for a Roku TV
To install the Dolby test application onto a Roku TV, you must first enable the Roku Developer
Application Installer.

Prerequisites

• The Roku TV is connected to a display (for example, a TV).

About this task
Only the essential steps are provided here. For detailed information about enabling a Roku
device for development, refer to the Roku Developer setup guide  at https://developer.roku.com.

Procedure

1. Enter this sequence with the Roku remote control to enter the Developer Settings page.

2. Save the Roku TV URL.

The Roku TV URL is shown in the Developer Settings page (for example, http://
10.12.12.13).

3. Set a password for the Roku TV, and reboot the device.

5.8.2 Installing the test application onto the Roku TV
Install the Dolby test application onto the Roku TV by using a web browser.

Prerequisites

• You must have access to the Dolby Digital Plus Online Delivery Kit.

• The Roku Developer Application Installer is enabled.

• Both the Roku TV and the PC for deploying the test application must be connected to the
same subnet.

Procedure

1. Download or copy the Roku_app.zip file to an appropriate directory on the PC.

If you have had the kit downloaded and unpacked on your local PC, locate the .zip file in the
<kit parent directory>/Test_Apps/ directory.

Otherwise, download the .zip file from the web page <kit starting page>/Test_Apps/ on the DISC
website (https://disc.dolbycustomer.com).

2. Open a web browser on the PC, and enter the Roku device URL (for example, http://
10.12.12.13).

3. Enter the user name and password.

The main page for installing an application appears.
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4. Click Upload, and select the Roku_app.zip file.

5. Click Install.
The test application icon appears on the Roku TV.

5.8.3 Test application controls
Operate the test application to perform different types of test cases. Controls on the test
application can be adjusted by using the remote control.

Playing test signals on the Roku TV

The test signals are organized by online delivery formats. Use the remote control to start
playing test signals.

Procedure

1. Start the test application.

2. Use the remote control to navigate through test signals, and play a highlighted test signal by
pressing the OK key on the remote control.

Fast forwarding and rewinding

Procedure

1. Click the right arrow on the remote control to fast forward the video.

2. Click the left arrow on the remote control to rewind the video.

5.9 Test application for Chromecast
This test application verifies that the Chromecast device is able to play back Dolby Digital Plus
bitstreams.

5.9.1 Accessing the test application
The test application is a web-based video player that can be opened in the Google Chrome web
browser.
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About this task
We recommend using a PC or Mac for running the test. You may need to upgrade the Chrome
web browser to the latest version to have the cast capability.

Procedure

1. Connect the Chromecast device to a TV.

For detailed information, see https://store.google.com. Make sure that the Chromecast
device and your testing PC is in the same LAN network. We recommend using cable
connections to the same router.

2. Open the Chrome web browser on the PC, and enter this URL:

http://d9zmmjtv72w5o.cloudfront.net/OnDelKits/DDP/
Dolby_Digital_Plus_Online_Delivery_Kit_v1.4/Test_Apps/ChromeCast_app/index.html

The test application GUI appears.

Figure 24: Chromecast test application GUI

3. Mirror the content from the PC to the TV.

To mirror the content, you can either click the Cast icon  available on the upper-right

corner of the Chrome web browser, or click the Start App button on the lower-right corner of
the test application UI.

To stop mirroring, click the Cast icon  again or the Stop App button.

5.9.2 GUI overview
All application functions can be managed through the GUI workspace.
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Figure 25: Test application GUI

1 Playlist
Displays a list of test signals. Test signals are organized in a hierarchy.

2 Stop App
Stops mirroring content to a TV.

3 Start App
Starts mirroring content to a TV.

4 Playback window
Displays video content of a currently playing test signal.

5 Menu
Contains options Load a single URL, About, and Back.

6 Output
Displays information such as playback status, bit-rate information, error messages, and so
on.

7 Playback control
Use these keys to control the playback process. (From left to right, keys include previous,
rewind, play, pause, stop, fast forward, and next.)

5.9.3 Locating a test signal from the test application GUI
After you have completed the questionnaire from Playback kit Interactive Test Procedure, a
test-case list required for your system is generated. With information shown in the test-case
list, you can locate the correct test signal from the test application GUI for testing.

About this task

The test-case list contains this information: the online delivery format, profile, video codec, and
test-case type.
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Figure 26: An example of a test-case list generated in the interactive test procedure

In the Test case column, the first two digits indicate the test-case type.

Table 8: Test-case type
First two digits Test-case type

01 ChID_2ch

02 ChID_6ch

03 ChID_8ch

04 ChID_6ch_atmos

05 little_endian

06 dual_decoding

07 multi_lang

08 multi_codec

09 multi_av_rate

10 multi_video_rate

11 music

12 crc

13 box

14 codec

15 av_sync

16 av_sync_6ch_atmos

In the test application, test signals are organized by supported features in this structure:

• <Online_delivery_format_profile>

• <Video_codec>

• <Test_case>

You must reference the information indicated in the test-case list to locate a specific test signal
from the test application GUI. For example, to locate the test signal of the first row shown in
this figure, you must follow these steps.
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Procedure

1. In the test application GUI, select the correct <Online_delivery_format_profile> (in this case,
DASH_Live).

2. Select the correct <Video_codec> (in this case, H.264).

3. Select the correct <Test_signal> to play (in this case, ChID_2ch).

For inquiring the test case type, see the table Table 8 on page 92.

4. You must repeat steps 1 to 3 to complete all required tests listed for your system
capabilities.

5.9.4 Playing test signals
Test signals are streamed from the DISC server.

All available test signals are listed in the Playlist. You can play a test signal by single-clicking on
it. Alternatively, you can use the Loop on/off function to play all of the test signals one after
another automatically starting from the currently playing signal.

Playback status is indicated in the Output panel. When encountering issues during playback,
error messages are displayed in the Output panel.

Playing a test signal by specifying a URL

It is also possible to play a test signal by entering its URL.

Procedure

1. Go to the Menu, and select Load Single URL.

2. Enter the URL of an individual test stream in the address bar.

3. Select the Load button to play the test signal.

If an incorrect URL is entered, clicking the Load button returns the application to its main
view.

If successfully loaded, the test signal starts playing back.

5.9.5 Fast forwarding and rewinding

Procedure

1. Click the fast-forward button on the GUI once to jump forward ten seconds.

2. Click the rewind button on the GUI to jump back ten seconds.
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Glossary
A/V

Audio/video.

AAC
Advanced Audio Coding. A perceptual audio coding system that is described by ISO/
IEC 14496‑3. 

access unit
All of the frames required by a Dolby Digital Plus decoder to produce 1,536 samples of
decoded audio for each channel present in the bitstream (including all substreams). The first
frame of an access unit has a substream type of 0 and a substream ID value of 0. If the
access unit consists of frames that contain one, two, or three blocks of audio, the first
frame of the access unit has the convsync parameter set to 1.

AC‑4 simple transport frame
Frame in AC-4 simple transport format that encapsulates a raw AC-4 frame, as defined in
ETSI TS 101 154 v1.11.1.

AIT
Application Information Table. A part of the digital video broadcast specification that
defines information that a broadcast receiver requires to be able to run applications
available from the program manager. This can include class files, data files, and activation
state, among others.

ARC
Audio Return Channel. A feature of HDMI that enables audio to be sent through the HDMI
cable from the sink to the source.

bed object
An object with positional metadata that does not change over time and is described by a
predefined speaker position.

block
A portion of a frame.

CE‑HTML
Consumer Electronics Hypertext Markup Language. An XHTML language for designing web-
based material for consumer electronic devices on Universal Plug and Play networks, as
defined in CTA-2014‑B.

CRC
Cyclic redundancy check.

DASH
Dynamic Adaptive Streaming over HTTP. An adaptive bit-rate streaming protocol that
enables high-quality streaming of media content over the Internet delivered from HTTP.

DECE
Digital Entertainment Content Ecosystem.
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DISC
Dolby Interoperability Support Center.

dynamic object
An object with positional metadata that may vary over time and is described by three
coordinates (x, y, z).

elementary stream
A bitstream that is the output of an audio or video encoder and contains only one type of
data, such as audio or video.

E‑AC‑3
Enhanced AC‑3.

Dolby Digital Plus, also known as Enhanced AC-3 or E-AC-3, is a digital audio compression
coding system for transport and storage of multichannel digital audio specified in Annex E
of ATSC A/52 and Annex E of ETSI TS 102 366.

The file extension for a Dolby Digital Plus file is .ec3.

frame
In audio, a series of PCM samples or encoded audio data representing the same time
interval for all channels in the configuration. Metadata pertaining to the frame can be
carried within the frame or separately, depending on context.

frame set
Six consecutive blocks of Dolby Digital Plus audio data from a single substream. A frame set
always represents 1,536 samples of audio data from a single substream.

GUID
Globally unique identifier. A unique reference number used as an identifier in software.

HDMI
High-Definition Multimedia Interface. A high-speed, high-capacity format for transferring
digital information and the specific hardware interface for the format.

HEVC
High-Efficiency Video Coding. See H.265.

HLS
HTTP Live Streaming. An adaptive streaming protocol for delivery of media content
developed by Apple.

ISO
International Organization for Standardization.

JDK
Java Development Kit.

joint object coding
An algorithm used to efficiently code object-based audio content.

media assets
A collection of files that contains a multimedia presentation formatted for adaptive
streaming. Generally, a media asset consists of multiplexed and fragmented media and one
or more files that describe how to play back the media (for example, playlist or manifest
files).
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media presentation
A collection of files that contains media content prepared for adaptive streaming. The
presentation includes media files that contain the content and files that describe how to
access and play the content.

MP4 sample
A single ISO base media file track sample, as defined in section 3.1.10 of ISO/IEC 14496‑12 .

MPD
Media Presentation Description. A manifest used in MPEG Dynamic Adaptive Streaming over
HTTP (MPEG-DASH) to describe the available streaming content, its various alternatives,
URL addresses, and other characteristics, as well as segments that contain the actual
multimedia bitstreams in the form of chunks, in single or multiple files.

MPEG
Moving Picture Experts Group. An ISO/IEC working group that develops video and audio
encoding standards. Also the name of a family of digital video and audio coding standards.

MPEG‑4
An MPEG standard (ISO/IEC 14496) for a group of audio and video coding formats and
related technologies.

object
An audio signal plus associated object audio metadata.

object audio metadata
Information used for rendering an audio object. Comprises metadata such as positional
metadata, content metadata, or metadata for personalization. Each object must at least
have associated positional metadata containing specific information for the renderer. The
specification of positional metadata is different for each object type.

object audio renderer
Renders object-based audio to a specific speaker layout. The input is composed of objects,
and the outputs are speaker feeds.

PAT
Program Association Table. Program Association Table of an MPEG‑2 transport stream.

PCR
Program clock reference. A periodically transmitted value of 42 bits that provides a sample
of the system time clock in the encoder and which is used to properly demultiplex packets
and to ensure that audio and video are synchronized.

PES
Packetized elementary stream. An elementary stream that is split into small chunks
(packets) for transmitting and combining multiple streams within a transport stream. Each
PES is identified by a unique packet identifier (PID).

PID
Packet identifier. A unique code that identifies a packetized elementary stream (PES) within
a transport stream. The PID is contained in the transport stream packet header and is listed
in the service information (SI) for a transport stream.

playlist
An extended .m3u8 file that contains one or more uniform resource identifiers (URIs). A URI
can point to another playlist or to a media file.
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PMT
Program Map Table. A table within an MPEG‑2 transport stream that defines the set of
elementary streams associated with a specific program.

presentation
References to AC‑4 substreams to be decoded and presented simultaneously.

presentation configuration
Set of metadata to describe how a presentation must be decoded.

PTS
Presentation time stamp. The presentation time stamp is contained in the packetized
elementary stream (PES) packet header that indicates when an access unit should be
decoded and presented for output. The PTS is used in combination with other time stamp
parameters to synchronize audio and video.

raw AC‑4 frame
The actual codec frame that consists of a table of contents plus several byte-aligned
substreams.

S/PDIF
Sony/Philips Digital Interconnect Format. A digital interface protocol and specification for a
physical connector for carrying digital audio signals, defined in IEC 60958.

substream
A decodable unit that represents a specific channel configuration (mono, stereo, or 5.1) and
contains audio data and corresponding metadata.

substream ID
A metadata field in a Dolby Digital Plus bitstream for numbering a substream. The
substream ID, in combination with the substream type, identifies a substream within a
Dolby Digital Plus stream, as defined in Annex E of ETSI TS 102 366.

substream type
A metadata field in a Dolby Digital Plus bitstream that describes a substream. There are
different types of substreams that make up a Dolby Digital Plus bitstream. As defined in
Annex E of ETSI TS 102  366, independent substreams (type 0) may be decoded
independently of any other substreams that might exist in the bitstream. Dependent
substreams (type 1) must be decoded in conjunction with the independent substream with
which it is associated.

time slice
A collection of Dolby Digital Plus frames that represents the audio data from the same point
in time across multiple substreams. A time slice may represent one, two, three, or six blocks
of audio data, depending on the number of blocks used per frame.

transport stream
As defined in ISO/IEC 13818‑1, a packetized bitstream that is used to transmit audio and
video information. A transport stream is made up of multiplexed program elementary
streams.

transport stream segment
A single .ts file that is part of an HTTP Live Streaming (HLS) transport stream.
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URI
Uniform Resource Identifier. A group of characters identifying a resource on a network
(typically, the Internet).

variant playlist
A playlist that contains Uniform Resource Identifiers (URIs) that point to alternative content
for a presentation, such as alternative language versions of the content. A variant playlist
lists URIs for each variant presentation so that a playback client can switch between
playback of the streams dynamically based on parameters such as language, bit rate, and
channel configuration.
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